


Active Datasource field
Purpose:    The Active Datasource field displays the current datasource you are connected 

to.    It is for informational purposes only and can only be changed by connecting 
to a datasource.

See Also:
Connect To Datasource
Datasources Window



Add WHERE Clause
Purpose:    This button/menu option is used to add a SQL WHERE clause to the Where 

Clause List field.    The information used in building the WHERE clause is the 
Column Name Selected, the Comparison selected, the Column Value Entered, 
and the And/Or value (if entered).
For example if the column name selected is FIRST_NAME, the comparison 
selected is CONTAINS, the column value entered is A, and the And/Or value 
selected is AND, the following line will be added to the Where Clause List:

FIRST_NAME      like      '%A%'      AND
Each time this button/menu option is selected an additional line is added to the 
end of the Where Clause List.    The lines in the Where Clause List are combined 
to build a single SQL WHERE clause used with a SQL SELECT statement.
For example if the following lines are added to the Where Clause List :

FIRST_NAME      like      '%A%'      AND
LAST_NAME      =      'Smith'      AND

The SQL WHERE Clause added to a SQL SELECT statement would be:
SELECT    *    FROM    TABLE1    WHERE    FIRST_NAME    like    '%A%'    AND    
LAST_NAME    =    'Smith'
Notice the last And/Or value has been removed from the WHERE clause built.

When Active:
This button/menu option is only visible when the SQL Where Clause Criteria Window is 
being used.    It is enabled after a column name has been selected in the Column Name 
List field.

Quick Key: None 

Toolbar Button: 
Using Menu:    Add to WHERE Clause from the WHERE Clause Menu
See Also:

Creating Queries
SQL Where Clause Criteria Window
Where Clause List field



And/Or Selection field
Purpose:    The And/Or Selection field is used to chain multiple WHERE clause statements 

together when a SQL WHERE clause is built.    The WHERE statements are stored 
in the Where Clause List field.
For example if the following WHERE statements are added to the Where Clause 
List field :

FIRST_NAME      like      '%A%'      AND
LAST_NAME      =      'Smith'      AND

The SQL WHERE Clause built would be:
                      WHERE    FIRST_NAME    like    '%A%'    AND
                                              LAST_NAME    =    'Smith'
Notice the last And/Or value is removed from the WHERE clause built.

Using:    To select an And/Or value, click on the arrow at the right of the list box to 
display both the AND and OR values.    Then click on one of the values to select it.
For example if you wanted to create the following SQL WHERE clause :
WHERE      NAME      =      "MIKE"     AND      STATE      =      "GA"
You would select AND from the And/Or Selection field when building the first 
WHERE statement (NAME      =      "MIKE").
This field is disabled until a column name is selected from the Column Name List 
field.
Note:    An AND/OR value is always added to the end of a WHERE statement 

regardless if multiple WHERE statements are added. The last AND/OR value
is then removed when the WHERE clause is actually built.
For example, after adding two WHERE statements to the Where Clause List 
field, the WHERE clause list may look like this:
          NAME      =      "MIKE"     AND 
          STATE      =      "GA"      AND
When the WHERE clause is actually built, the second AND (STATE      =      
"GA"      AND) will be removed and the WHERE clause built will be:
WHERE      NAME      =      "MIKE"      AND      STATE      =      "GA"

See Also:
Column Name List field
Creating Queries
SQL Where Clause Criteria Window



Auto Execute Query field
Purpose:    The Auto Execute Query field determines whether a Query is automatically 

executed after the Build SQL button        or menu option is selected.
Using:    If box is checked: After selecting the Build SQL button or menu option, the 

query that gets built is automatically executed.    You do not need to use the Run 
Query button or menu option to run the query.
If box is not checked: After selecting the Build SQL button or menu option, you
must use the Run Query button or menu option to run the SQL that was built.

See Also:
Build SQL
Run Query
Preferences Window



Build SQL
Purpose:    This button/menu option is used to build a SQL SELECT statement using the 

following information:
          *    Selected columns from the Column List field
          *    WHERE Clause, if entered
          *    ORDER BY Clause, if entered
          *    GROUP BY Clause, if entered
          *    DISTINCT if selected on the Query Menu
Note:    If the AUTO EXECUTE SQL Preference option is turned on, the SQL Query 

created as a result of this button/menu option will be automatically 
executed.    You will not have a chance to view or change the SQL Query 
prior to it's execution.

When Active:
Datasources Window

This button/menu option is enabled if at least 1 column is selected in the Column List 
Field.

SQL Where Clause Criteria Window
This button/menu option is always enabled.    However, if no WHERE Clause 
information has been entered, the SQL SELECT will be built without a WHERE Clause 
and a message will be displayed acknowledging this.

Order/Group By Clause Window
This button/menu option is always enabled.    However, if no ORDER/GROUP BY Clause
has been entered, the SQL SELECT will be built without an ORDER/GROUP BY Clause 
and a message will be displayed acknowledging this.

Quick Key: CTRL-B 

Toolbar Button: 
Using Menu:    Build SQL Statement from the Query Menu
See Also:

Auto Execute Query field
Column List field
Creating Queries
Datasources Window
Run Query
Order/Group By Clause Window
Query Window
SQL Where Clause Criteria Window



Clear Window
Purpose:    This button/menu option is used to clear (erase) information from a window or 

list.    The information cleared depends on which field/window the cursor is in (See
below).

When Active:
Query Window

This button/menu option is always active. When pressed, the text in the Query 
Window will be erased.    If there is no text to be erased, nothing happens.

SQL Where Clause Criteria Window
This button/menu option is always active. When pressed, all of the Where Clause 
statements in the Where Clause List field will be erased.    If the list is empty, nothing 
happens

Order/Group By Clause Window
This button/menu option is always active. If the cursor is in the Order By Clause List 
field, all of the entries in the Order By Clause list will be erased.    If the cursor is in 
the Group By Clause list field, all of the entries in the Group By Clause list will be 
erased.

Quick Key: None 

Toolbar Button: 
Using Menu:    Clear from the Edit Menu
See Also:

Group By Clause list field
Order By Clause List field
Order/Group By Clause Window
Query Window
SQL Where Clause Criteria Window



Column Details Window
Purpose:    The Column Details Window is used to display the following information about a

column in a table:
Column Name
Data Type (Character, Date, Number, etc.)
Length
Can the column have a NULL value
USED WITH SQL SERVER DATABASES ONLY:

SQL Server Rule bound to the column
SQL Server Default bound to the column

Accessing:    The Column Details Window can be accessed in the following ways:
From the Column List Field on the Datasources Window:

1)      Double Click on a column name
2)      Click on column name then select the COLUMN DETAILS menu 

option on the Datasources Menu or the Pop Menu.
From the Table Columns List Field on the Table Details Window:

1)      Double Click on a column row
2)      Click on Column name then select the COLUMN DETAILS menu 

option on the Datasources Menu or the Pop Menu.
Drag and Drop: The following Drag and Drop operations may be performed from this 

window:
Both the SQL Server Default and SQL Server Rule may be dragged and 
dropped onto a Query Window.    This will retreive the source for the Default
or Rule and display it in the Query Window.

Fields:    The following fields are located on the Column Details Window.    Click on the 
field name to view information about the field.
Column List field
Column Name List field
SQL Server Default field
SQL Server Rule field
Table Columns List field

See Also:
Datasources Menu
Drag and Drop
Pop Up Menu
Table Details Window



Extended Selection
Extended Selection enables you to quickly select multiple items within a list.    The following
key combinations are used in Extended Selection:
(Shift+Click) or (Shift+Arrow Key) extends the selection from the previously selected 
item to the current item. For example, if you select the first item in a list, then while 
holding down the Shift Key click on the fifth item in the list, items 1 through 5 will be 
selected (hilighted).    If you first select the fifth item in a list, then while holding down the 
Shift Key click on the first item in the list, items 1 through 5 will also be selected 
(hilighted).    Therefore, you do not need to click on items in any given order.
(Ctrl+Click) selects or deselects an item in the list.    This enables you to select/deselect 
multiple columns.    For example, if you select the first item in a list, then while holding 
down the CTRL Key click on the fifth item in the list, both items 1 and 5 will be selected 
(hilighted).    If you then while holding down the CTRL Key click on the third item in the list, 
items 1, 3 and 5 will be selected (hilighted).
If neither the CTRL nor Shift keys are pressed while clicking on an item in the list, only the 
item selected will be hilighted.    All other previously selected (hilighted) items will be 
deselected.



Column List field
Purpose:    The Column List field displays column names for selected tables in the Table 

List Field.    The column name is displayed in the format 
table_name.column_name where table_name is the name or the table the 
column belongs to and column_name is the name of the column.

Using:    The primary purpose of the column list field is to select one or more columns to
be used in building SQL SELECT Queries.    For further information about building 
SQL SELECT Queries refer to the help topic Creating Queries.
Selecting/Deselecting Columns

To select a column, click on the column name.    The column should now be 
selected (hilighted).    To deselect a column click on the hilighted column.    
The column should no longer be hilighted.

Selecting All Columns in the list
To select all columns in the column list, select SELECT ALL COLUMNS from
the Query Menu or the Pop Menu.

Deselecting All Columns in the list
To quickly deselect all columns in the column list, double-click on the 
Columns button  above the column
list field.

Viewing Column Information
To view detailed information about a column, double-click on a column 
name.    This will display the Column Details Window.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
Column Details - Displays Column Details for the last selected column.
Build SQL Statement - Builds a SQL SELECT query using the selected 
columns.
Select All Columns - Selects all columns in the column list and Builds a SQL 
SELECT query using all the selected columns.

See Also:
Column Details Window
Creating Queries
Datasources Window
Pop Up Menu



Column Name List field
Purpose:    The Column Name List field is displayed on the following windows :

SQL Where Clause Criteria Window
Order/Group By Clause Window

On both windows, the field displays all columns listed in the Column List field on 
the Datasources Window.    These columns are available to build a SQL WHERE 
Clause, SQL ORDER BY Clause, or SQL GROUP BY Clause depending on the 
window you are on.    The column names are displayed in the format 
table_name.column_name where table_name is the name of the table the 
column belongs to and column_name is the name of the column.

Using:    The use of this field varies between the windows it is used on and will therefore
be explained by window.
SQL WHERE Clause Criteria Window

Selecting/Deselecting Columns
To select a column to be used in a WHERE statement, click on the column 
name.    The column should now be selected (hilighted).    The name of the 
selected column will also be displayed below the column name list field.    Only
one column may be selected at a time.    To select a different column, you 
must first deselect the prior column selected.    This is necessary because of 
the drag and drop feature described below.
To deselect a column click on the hilighted column.    The column will no 
longer be hilighted.
Once a column is selected, the other fields on the window may be completed.  
After completing the necessary field, the WHERE statement for that column 
may be built by using the Add To Where Clause toolbar/menu option.
Joining Two Tables
Once a column is selected, a different column in the list may be dragged and 
dropped onto the Value Field.    This is an easy way to create SQL JOINS 
between one or more tables.
For example, assume columns for two tables (T1 and T2) are displayed in the 
column name list (accomplished by selecting two tables from the table list 
field on the Datasources Window).    Each table has a column named 
CUSTOMER_NUMBER.    To create a JOIN between the two tables, you would 
first select the CUSTOMER_NUMBER column from one of the tables.    After 
selecting the column, drag the column named CUSTOMER_NUMBER from the 

second table ( you should see the drag icon ) and drop it onto the Value 
Field.    The WHERE statement built for the join will be:
WHERE T1.CUSTOMER_NUMBER = T2.CUSTOMER_NUMBER

Order/Group By Clause Window
Selecting/Deselecting Columns
To select a column to be used in an ORDER BY/GROUP BY statement, click on
the column name.    The column should now be selected (hilighted).    Only one 
column may be selected at a time.    To select a different column, simply click 
on the new column.    The first selected column will automatically be 
deselected.



To deselect a column click on the hilighted column or click on a different 
column.    The column will no longer be hilighted.
Once a column is selected, it may be added to either the Order By or Group By
List Field by selecting the appropriate menu option.
Dragging a Column Name to the Order By or Group By List
A column can be dragged and dropped onto either the Order By or Group By 
List Field.    Doing so will automatically create the appropriate ORDER 
BY/GROUP BY statement.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
SQL WHERE Clause Criteria Window

Add To WHERE Clause - Adds a WHERE statement to the WHERE Clause 
List Field based on the information entered into the various fields on the 
window.
Build SQL Statement - Builds a SQL SELECT statement using the following 
information:

*    Selected columns from the Column List Field on the Datasources Window
*    WHERE Clause, if entered
*    ORDER BY Clause, if entered
*    GROUP BY Clause, if entered
*    DISTINCT if selected on the Query Menu

Order/Group By Clause Window
Add To Order By Clause - Adds an ORDER BY statement to the Order By 
List Field based on the column selected and the Order By Sort Sequence 
field.
Add To Group By Clause - Adds an GROUP BY statement to the Group By 
List Field based on the column selected.
Build SQL Statement - Builds a SQL SELECT statement using the following 
information:

*    Selected columns from the Column List Field on the Datasources Window
*    WHERE Clause, if entered
*    ORDER BY Clause, if entered
*    GROUP BY Clause, if entered
*    DISTINCT if selected on the Query Menu

See Also:
And/Or Selection field
Column Value field
Comparison List field
Group By Clause list field
Order By Clause List field
Order By Sort Sequence field
Pop Up Menu
SQL Where Clause Criteria Window



Where Clause List field



Column Value field
Purpose:    The Column Value field is used to build the SQL WHERE clause.    It is the value 

to which the Selected column will be compared.
Using:    After selecting a column from the Column Name field and specifying a 

comparison value, you enter a value into the Column Value field to be compared 
to the selected column.    For example, if you want to create a WHERE clause 
which compares the column USER_NAME to the value "MIKE", you would perform 
the following steps :
1)    Select the Column Name USER_NAME from the Column Name field.
2)    Select the value EQUAL from the Comparison List field.
3)    Enter the value MIKE into the Column Value field.
4)    Build the Add the statement to the WHERE Clause.

Drag and Drop:    Once a column name is selected, a different column in the Column 
Name field may be dragged and dropped onto the Column Value Field.    
This is an easy way to create SQL JOINS between one or more tables.
For example, assume columns for two tables (T1 and T2) are displayed in 
the column name list (accomplished by selecting two tables from the table 
list field on the Datasources Window).    Each table has a column named 
CUSTOMER_NUMBER.    To create a JOIN between the two tables, you would 
first select the CUSTOMER_NUMBER column from one of the tables.    After 
selecting the first column, drag the column named CUSTOMER_NUMBER 

from the second table ( you should see the drag icon ) and drop it on 
the Value Field.    The WHERE statement built for the join will be:

WHERE      T1.CUSTOMER_NUMBER      =      T2.CUSTOMER_NUMBER
See Also:

And/Or Selection field
Column Name List field
Comparison List field
Creating Queries
SQL Where Clause Criteria Window
Where Clause List field



Comparison List field
Purpose:    The Comparison List field is used to build the SQL WHERE clause.    It specifies 

the comparison (equals, greater than, less than, etc.) between the Column Name
selected and the Column Value entered.

Using:    After selecting a column from the Column Name field, select one of the 
following values from the Comparison List field.    The WHERE statement built by 
each value is displayed.
Equals (Used with numbers and text)

Creates:    COLUMN_NAME    =    COLUMN VALUE
Not Equal (Used with numbers and text)

Creates:    COLUMN_NAME    <>    COLUMN VALUE
Greater Than (Used with numbers only)

Creates:    COLUMN_NAME    >    COLUMN VALUE
Less Than (Used with numbers only)

Creates:    COLUMN_NAME    <    COLUMN VALUE
Starts With (Used with text only)

Creates:    COLUMN_NAME    LIKE    COLUMN VALUE%
Contains (Used with text only)

Creates:    COLUMN_NAME    LIKE    %COLUMN VALUE%
See Also:

And/Or Selection field
Column Name List field
Column Value field
Creating Queries
SQL Where Clause Criteria Window
Where Clause List field



Connect To Datasource
Purpose:    This button/menu option is used to connect to (log onto) a datasource.    This is 

necessary prior to performing any database activity.
Upon selecting this button/menu option the following will occur:

1)      A list of datasources will be displayed.    This list must have been 
previously established using the ODBC Administrator Facility.    Select which
datasource you want to connect to.

2)      If additional information is required to connect to the datasource, the 
appropriate windows will be displayed.    One of these windows may require 
a user ID and/or Password to be entered.    If a User ID and/or Password is 
required, the following default information will be used:
User ID: The User ID displayed will be the last User ID used to connect to 

the datasource.    If there is was no previous connection made to 
the datasource, the User ID will be the User ID used to connect to 
the previous datasource.    If there was no previous User ID, the 
User ID used will be the User ID entered in the User ID field on the 
Preferences Window. If a Preferences User ID has not been entered,
the User ID field will be blank and required to be entered.

Password:    The Password displayed will be the last password used to 
connect to the datasource if the Store Datasource Passwords 
field. on the Preferences Window is turned on.    If this field is 
turned off, the password used will be the password used to 
connect to the previous datasource..    If there was no previous 
password used, the password used will be the Password entered 
in the Password field on the Preferences Window if one was 
entered.    If no default password was entered on the Preferences 
Window, the password will be left blank and required to be 
entered.

3)      Upon connecting to the datasource, all tables residing in the 
datasource/database will be retrieved and loaded into the Table List Field.    
The datasource connected to is displayed in the Active Datasource field.    
The current database within the datasource (if applicable) is displayed in 
the Database field.

When Active:    This button/menu option is always active.
Quick Key: CTRL-T 

Toolbar Button: 
Using Menu:    Connect to Datasource from the Datasources Menu
See Also:

Preferences Window



Connecting To a Datasource
Prior to performing any database activity, you must first connect to a datasource..    The 
first step in connecting to a datasource is to define the datasource using the ODBC 
Administrator Facility..    This facility is used to tell MDS PowerBase what type of database 
the datasource is (i.e. Dbase IV, SQL Server, Oracle, etc.) and where the datasource "lives" 
(i.e. network information, which sub directory it is located in, etc.).
Connecting to a datasource is synonymous with logging onto or signing onto a database.    
There are three ways to connect to a datasource.    You can press the Connect To 

Datasource toolbar button    .    You can select Connect to Datasource from the 
Datasources Menu, or you can use the Quick Key: CTRL-T.
Upon selecting the button or menu option a list of datasources that have been previously 
defined using the ODBC Administrator Facility will be displayed.    From this list, you select 
which datasource you want to connect to.    After connecting to the datasource, all tables 
residing in the datasource/database will be retrieved and loaded into the Table List Field.    
The datasource connected to is displayed in the Active Datasource field.    The current 
database within the datasource (if applicable) is displayed in the Database field.
At this time you are ready to begin creating and executing SQL queries.
See Also:

Connect To Datasource
Creating Queries
Installing ODBC



Creating Queries
There are various ways to create queries within MDS PowerBase.    Queries are always 
created within MDS PowerBase using one of the Query Windows.    Up to 10    query 
windows may opened and in use at one time.    To create a query use one of the following 
techniques:
Note: After using any one of the techniques below, the query that is created may be 

changed before executing it.
Use the Column List field to build a SQL SELECT query.

The Column List field contains column names for tables that have been selected from 
the Table List Field.    Select one or more columns from the Column List field by clicking 
on the appropriate column name.    If you want the SELECT statement to be built as a 
DISTINCT query, select DISTINCT from the Query Menu.    After the columns you want to 
create a SQL SELECT query for are selected, perform one of the following actions to 
create the SQL SELECT query in the current Query Window:

Press the Build SQL button on the toolbar    
Select BUILD SQL Statement from the Column List field Pop Up Menu
Select BUILD SQL Statement from the Query menu.

To create a SQL SELECT query using all the columns displayed in the Column List field, 
select the SELECT ALL COLUMNS menu option on either the Column List field Pop-Up 
menu, or on the Query menu.
After the SQL SELECT query is created, you can use the SQL WHERE Clause Criteria 
Window, and SQL ORDER/GROUP BY Window to add the appropriate SQL statements to 
the SQL SELECT Query that was created.
Note: If the SQL SELECT query built uses columns from more than one table, you will 

need to use the SQL WHERE Clause Criteria Window to create a table join between
the tables.    Failure to do so will most likely result in a Cartesian product result set.

Manually enter a query in a Query Window
Once you have connected to a datasource you can enter any type of SQL query 
(SELECT, CREATE, DROP, etc.) into one of the Query Windows.    When you manually 
create queries, the SQL WHERE Clause Criteria Window and SQL ORDER/GROUP BY 
Window cannot be used to append their associated SQL statements to the query you 
entered.

Drag and Drop a table name onto a Query Window
Using this Drag And Drop approach will create a SQL SELECT query selecting all columns
in the table dropped.    If you want the SELECT statement to be built as a DISTINCT 
query, select DISTINCT from the Query Menu prior to dragging and dropping the table.

Drag and Drop a SQL SERVER Object (Stored Procedure, Trigger, etc.) 
onto a Query Window

From the Referencing Objects Window (available only with SQL SERVER Datasources), 
Drag and Drop one of the objects onto a Query Window to retrieve the source for that 
object into the Query Window.    The source retrieved will be the CREATE statement for 
that object.    Once the objects' source is retrieved, you can modify it and re-load it back 
to the Datasource (Server) by running the query (SQL).
Note: Prior to running the query, you will need to add a DROP statement to DROP the 
object before it is re-loaded.



Load a previously saved query into a Query Window
Queries can be loaded from files by using the OPEN menu option.    This menu option is 
located on the Query Window Pop-Menu and the File menu.    Selecting OPEN from one 
of these menus will present you will a window from which you can select a file to open.    
Opening a file will retrieve the text of the file into the current Query Window.    At this 
time, the query can be changed or executed as-is.

See Also:
DISTINCT Parameter
Order/Group By Clause Window
Referencing Objects Window
Run Query
Query Window
SQL Where Clause Criteria Window
Using the Menu
Using the Toolbar



Database field
Purpose:    The Database field displays the current database within the datasource you are

connected to.    It is for informational purposes only and can only be changed 
when connecting to a datasource.

See Also:
Connect To Datasource
Datasources Window



Datasources Menu
The Datasources Menu contains selections specific to a datasource and it's objects (tables, 
databases, columns).    The following selections are available from the menu:
Connect To Datasource

This selection is used to connect to (log onto) a datasource.    This is necessary prior to 
performing any database activity.

See also: Connect To Datasource
Table Details

This selection displays the Table Details Window.
Column Details

This selection displays the Column Details Window
See Also:

Pop Up Menu
Using the Menu
Using the Toolbar



Datasources Window
Purpose:    The Datasources Window is used to process tables and table columns within 

the datasource.    MDS PowerBase uses these two objects in creating SQL SELECT 
queries.

Using:    A sample flow of processing on the Datasources Window is:
1)    Connect to a datasource.
2)    Select 1 or more tables from the Table List Field to Process.
3)    Select 1 or more columns from the Column List Field to Process.
4)    Build a SQL SELECT query using the Columns selected.

Fields: The following fields are located on the Datasources Window.    Click on the field 
name to view information about the field.
Active Datasource field
Database field
Table List Field
Column List field

See Also:
Build SQL
Column Details Window
Connect To Datasource
Datasources Menu
Table Details Window



Directories List field
Purpose:    The Directories List Field is located on the SQL Script Facility Window.    It is 

used to select a directory in which files will be displayed in the Files List field.    
The directories displayed in this field are affected by the selection made in the 
Drives List field.

Using:    To list files in the Files List field within a given directory, select the directory in 
this field by double clicking the mouse button while pointing the mouse arrow 
over the appropriate directory.
Each directory displayed in this field has a folder displayed next to it.    The folder 
will either be open or closed.
If the folder is closed, double-clicking on the directory will open the folder and 
display all sub-directories (if they exist) of the directory clicked on.    In addition, 
any files with the extension selected in the File Types Field within the selected 
directory will be displayed in the File List field.

See Also:
Drives List field
Files List field
File Types List field
SQL Script Facility Window



Display Query Results In field
Purpose:    The Display Query Results In field determines whether the results of an 

executed query will be displayed in a Query Result Window within MDS 
PowerBase, or be loaded into a text editior.    The field is located on the 
Preferences Window.

Using:    Text Editor: Selecting this option will cause the results of an executed query 
to be displayed in the text editor identified in the Text Editor field.    If this option 
is selected, the path and name of a text editor must be entered in the the Text 
Editor field or an error will occur when the query results are displayed.
Window: Selecting this option will cause the results of an executed query to be 
displayed in a Query Result Window within MDS PowerBase.    If this option is 
selected, the Use Separate Query Result Windows field will be enabled.    The Use 
Separate Query Result Windows field controls whether a single query result 
window is re-used to display query results, or separate query result windows (up 
to 10) will be used to display the results of different queries.

See Also:
Preferences Window
Query Result Window
Text Editor field
Use Separate Query Result Windows field



DISTINCT Parameter
Purpose:    The Distinct parameter is a selection on the Query Menu and Query Pop-Up 

menu.    It is used to create SQL SELECT DISTINCT queries.    It is only used when 
building queries using the Build SQL toolbar or menu selection.

Using:    If the DISTINCT menu selection is checked: Upon selecting the Build SQL 
button or menu option, the query that gets built will include the DISTINCT 
keyword.    For example:
        SELECT    DISTINCT    EMPLOYEE_ID    FROM    EMPLOYEE_TABLE
If the DISTINCT menu selection is not checked: Upon selecting the Build 
SQL button or menu option, the query that gets built will not include the 
DISTINCT keyword.    For example:
        SELECT    EMPLOYEE_ID    FROM    EMPLOYEE_TABLE

See Also:
Creating Queries
Pop Up Menu
Query Menu
Using the Menu



Drag And Drop
Drag and Drop is technique by which you click on a field, and while holding down the 
mouse button drag the field over another field or button, and release the mouse button 
(drop the object).    Upon dropping the field, an action is taken.
A typical use of drag and drop is clicking on file name, dragging the file name over a button
of a trash can, then dropping the file onto the trash can which causes the file to be deleted.
The following fields within MDS PowerBase have drag and drop capabilities :

Drag Field Drop On Field Action Taken
Table List Field Query Window SQL SELECT query is 

built selecting all 
columns in the table

File List field Query Window Text in file is loaded 
into Query Window

Execute SQL Script 
Toolbar Button

Text in file is 
executed as a query

Text Editor Toolbar 
Button

Text in file is loaded 
into the text editor 
specified in the 
Preferences Window

Object List Field Query Window Object source is 
retreived from SQL 
Server into Query 
Window

SQL Server Default Query Window SQL Server Default 
source is retreived 
from SQL Server into 
Query Window

SQL Server Rule Query Window SQL Server Rule 
source is retreived 
from SQL Server into 
Query Window

Table Triggers Query Window SQL Server Trigger 
source is retreived 
from SQL Server into 
Query Window

Column Name field 
(WHERE Clause 
Window)

Column Value Field Creates JOIN 
between Column 
Name selected and 
the Column Name 
dropped onto the 
Column Value Field

Column Name field 
(ORDER/GROUP BY 
Window)

Order By List Field Creates ORDER BY 
statement for the 
Column Name 
dropped

Column Name field 
(ORDER/GROUP BY 
Window)

Group By List Field Creates GROUP BY 
statement for the 
Column Name 



dropped

Drives List field
Purpose:    The Drives List Field is located on the SQL Script Facility Window.    It is used to 

select a drive in which directories and files will be displayed in the Directory List 
Field and Files List field respectively.

Using:    To list files in the Files List field within a given directory and drive, select the 
drive from the list presented.    Upon selecting a drive, the directories within the 
drive will be displayed in the Directory List Field.    Also, any files with the 
extension selected in the File Types Field within the current directory will be 
displayed in the File List field.

See Also:
Directories List field
Files List field
File Types List field
SQL Script Facility Window



database drivers
A database driver is a Dynamic Link Library (DLL) that implements ODBC function calls and
communicates with one or more database management systems.



datasource
A data source includes the data a user wants to access within a specific database 
management system (DBMS) and the information necessary to retreive that data.
Examples of data sources are :

Microsoft Access Databases (MDB'S) and the directories in which they reside
SQL Server Databases and the servers they reside on.



Edit Menu
The Edit Menu contains selections for managing text within various MDS PowerBase 
windows.    The following selections are available from the menu:
Clear

This selection clears (erases) the text from a window.    For example, choosing this 
selection while on a Query Window will erase the text in the query window.

Copy
This selection copies selected (hilighted) text to the Windows Clipboard.

Cut
This selection cuts (deletes) the selected (hilighted) text from a given window/field and 
copies it to the Windows Clipboard.

Paste
This selection copies text from the Windows Clipboard to a given field.    The text is 
inserted where the cursor is within the field being copied to.

Find
This selection displays a window to be used for locating text within a Query Result 
Window.

Find Next
This selection finds the next location of the text being searched for within a Query Result
Window.    It assumes the FIND selection had been previously made.

Find Previous
This selection finds the previous location of the text being searched for within a Query 
Result Window.    It assumes the FIND selection had been previously made.

See Also:
Pop Up Menu
Using the Menu
Using the Toolbar



Exceute SQL Script
Purpose:    This button/menu option is used to execute the SQL in the files selected on the 

SQL Script Facility Window.
Upon selecting this button/menu option the following will occur:

1)    The text in each selected file (starting at the top of the list) is read and 
executed.

2)    The result set(s), if any, are displayed either in a query window or text 
editor (based on the value of the Display Query Results In field.    The 
results of each file are separated in the query results by a label specifying 
the name of the file being processed.    Any errors encountered during the 
query execution are also listed.

3)    The result of processing the file is displayed in the SUCCESSFUL or FAILED 
field on the SQL Script Facility Window.

Drag and Drop:    Files may also be dragged from the File List Field and dropped onto the 
Execute SQL Script button.    Doing so will run the SQL in the file dropped 
onto the button.

When Active:    This button/menu option is active only while working on the SQL Script 
Facility Window.

Quick Key: None 

Toolbar Button: 
Using Menu:    Execute SQL in Selected Files from the Query Menu
See Also:

Drag And Drop
Files List field
SQL Script Facility Window
Using the Menu
Using the Toolbar



Exit MDS PowerBase
Purpose:    This button/menu option is used exit the MDS PowerBase Program.
When Active: Always Active.
Quick Key: None

Toolbar Button: 
Using Menu:    Exit from the File Menu
See Also:

File Menu
Using the Menu
Using the Toolbar



File Menu
The File Menu contains selections for processing files, opening and closing windows, 
printing information, launching the various utilities within MDS PowerBase, and exiting MDS
PowerBase.    The following selections are available from the menu:
New

This selection opens a new Query Window.    A maximum of 10 Query Windows can be 
opened at the same time.

Open
This selection retreives a files text into a Query Window.

Save
This selection saves the text in a Query Window or Query Result Window into a file.

Close
This selection closes the current window.

Print
This selection prints table detail information for the tables selected in the Table List 
Field.    If it is used while you are working on the Table Details Window, it will print table 
detail information for the table whose information you are viewing.
While working on the Referencing Objects Window, this selection prints the objects listed
in the Object List Field.

Referencing Objects Window
Print Setup

This selection displays a printer setup window which enables you to specify printer 
information.    For example, margins, number of copies to be printed, whether to print 
landscape or portrait, etc.

SQL Script Facility
This selection displays the SQL Script Facility Window.

DOS Shell
This selection runs a DOS session within a window.

Configure ODBC
This selection launches the ODBC Administrator Facility..

Launch Editor
This selection runs the editor specified in the Text Editor field on the Preferences 
Window.

Preferences
This selection opens the Preferences Window.

Exit
This selection exits the MDS PowerBase application.

See Also:
Pop Up Menu
Preferences Window



Using the Menu
Using the Toolbar



File Save
Purpose:    This button/menu option is used to save information to a file.    The two types of

information that can be saved are Queries and Query Results.
When Active:

Query Window
This button/menu option is enabled if there is any text in the Query Window.    In 
addition, the cursor must be within the Query Window.    For example, if the Query 
Window has text in it, but the cursor is in the Column List field of the Datasources 
Window, the save button will not be enabled.

Query Result Window
This button/menu option is enabled if there is any text in the Query Result Window.    
In addition, the cursor must be within the Query Result Window.

Quick Key: CTRL-S 

Toolbar Button: 
Using Menu:    Save from the File Menu



File Types List field
Purpose:    The File Types List Field is located on the SQL Script Facility Window.    It is used 

to filter the files displayed in the Files List field.
Using:    The File Types List contains various entries each representing a different file 

extension.    Selecting a specific File Type will list only those files with the file 
extension selected.    For example, if you select the File Type SQL Files (*.sql), 
only files with the extension SQL will be listed in the Files List field.
Selecting the File Type All Files (*.*) lists all files in the selected directory 
regardless of their file extensions.

See Also:
Directories List field
Drives List field
Files List field
SQL Script Facility Window



Files List field
Purpose:    The Files List Field is located on the SQL Script Facility Window.    It lists all files 

meeting the criteria selected in the Drives, Directories, and File Types fields.    
One or more files may be selected from the list, and the SQL text within each file 
can be executed by using the Execute SQL Script button/menu selection.
The text within the files listed may also be viewed in the text editor specified in 
the Text Editor field on the Preferences Window.
The main purpose of the SQL Script Facility is to process files containing SQL 
queries.    For example, if you have a number of queries that you run each day, 
you could save the queries in one or more files.    Then using the SQL Script 
Facility Window, you could list and select each of the files from the Files List.    
After selecting the files from the list, you could press the Execute SQL Script 
toolbar button, and the queries in each of the files would be executed.    This 
approach is alot simpler than executing each query separately.
Another good use for the SQL Script Facility is to perform routine database 
maintenance.    For example, in a SQL Server environment you may store all the 
source for your stored procedures and triggers in text files.    Anytime you need to
make a change to one of these objects you could use the SQL Script Facility to 
list the text files, load the text into a text editor, change the source, save it , and 
re-load the source.

Using:    When the SQL Script Facility Window is first opened, the File List will display all 
files within the current drive/directory with the extension SQL.    By changing the 
Drive, Directory, or File Type, a different list of files can be displayed.    This field 
supports Extended Selection processing.
Viewing The Text Within Files

There are three ways to view the text within a file in the Files List.    They are:
1)      Double Click on a file in the list.
2)      Drag and Drop a file from the list onto the Text Editor toolbar button.
3)      Select a file from the list, then click on the Text Editor toolbar button 

or select Launch Editor from the File Menu.
Executing SQL Queries Stored Within The Files

There are two ways to execute the SQL queries stored within the files listed in 
the Files List.    They are:

1)      Drag and Drop a file from the list onto the Execute SQL Script toolbar 

button    .
2)      Select a file from the list, then click on the Execute SQL Script    toolbar button or select 
Process SQL In Selected Files from the Query Menu.

Drag and Drop:    There are three Drag and Drop features available from this field.    They 
are: 
1)      Drag and Drop a file from the File List onto the Execute SQL Script 

toolbar button to execute the SQL query within that file.
2)      Drag and Drop a file from the File List onto the Text Editor toolbar 

button to load the text within the file into the text editor specified in the 
Text Editor field on the Preferences Window.

3)      Drag and Drop a file from the File List onto a Query Window to load the



text within the file into the Query Window.
Pop Menu:    The following selections are on the Pop Up Menu for this field:

Execute SQL In Selected Files - Executes the SQL within the files selected in 
the File List.
Launch Editor - Loads the last selected file into the text editor specified in the 
Text Editor field on the Preferences Window.

See Also:
Directories List field
Drag And Drop
Drives List field
Exceute SQL Script
File Menu
File Types List field
SQL Script Facility Window
Using the Menu
Using the Toolbar



Find Next
Purpose:    This button/menu option finds the next location of the text being searched for 

within a Query Result Window.    It assumes the FIND selection had been 
previously made.

When Active: Active only when there are Query Results available to be searched.
Quick Key: CTRL-N
Toolbar Button: None.
Using Menu:    Find Next from the Edit Menu
See Also:

Find Previous
Search Criteria Window
Using the Menu



Find Previous
Purpose:    This button/menu option finds the previous location of the text being searched 

for within a Query Result Window.    It assumes the FIND selection had been 
previously made.

When Active: Active only when there are Query Results available to be searched.
Quick Key: CTRL-B (for Backwards)
Toolbar Button: None.
Using Menu:    Find Previous from the Edit Menu
See Also:

Find Next
Search Criteria Window
Using the Menu



Getting Help
There are two types of help available within MDS PowerBase.    They are Field Level Help 
and Window Level Help.    Field Level Help provides help about the current field you are 
working in.    Window Level Help provides help about the current window you are working 
on.
To obtain Field Level Help, press the F1 key or select Active Field from the Help Menu.
To obtain Window Level Help, press the Quick Key combination SHIFT-F1 or select Active 
Window from the Help Menu.
See Also:

Help Menu



Getting Started
Installing ODBC
Getting Help
Setting Up Preferences
Connecting To a Datasource
Creating Queries
Running Queries
See Also:

Using the Toolbar
Using the Menu



Group By Clause list field
Purpose:    The Group By Clause Field is located on the Order/Group By Window.    It lists all

the columns that will be used to build the GROUP BY clause of a SQL SELECT 
statement built using the Build SQL button/menu option.    This field has Extended
Selection capabilities.

Using:    Adding A Column Name To The List
There are two ways to add a column name to the Group By List Field (GROUP 
BY statement).    They are:

1)      Drag and Drop a column name from the Column Name field onto the
Group By List Field.    Doing this will add a GROUP BY statement for the 
column name dropped to the end of the list.

2)      Select (click on) a column name in the Column Name field.    Next 
select Add to Group By Clause from the Order/Group By menu, or 
from the Pop-Up menu of the Column Name field.    This will add a 
GROUP BY statement for the column name selected to the end of the 
list.

Regardless of the method used, the column name field is what is 
actually added to the Group By List.    The GROUP BY statement for all
the columns in the list is built upon selecting the Build SQL 
toolbar/menu option.

Removing A Column Name From The List
There are two ways to remove one or more column names from the Group By 
List Field (GROUP BY statement).    They are:

1)      Select (click on) one or more column names in the list.    Press the 
DELETE key on your PC.

2)      Select (click on) one or more column names in the list.    Select the 
Remove From Group By Clause menu option from the Order/Group By
Menu or the Group By List Field Pop-Up Menu.

Clearing (Removing All Column Names) The List
There are two ways to remove all the column names from the Group By List 
Field (GROUP BY statement).    They are:

1)      Select the Clear Group By Clause menu option from the 
Order/Group By Menu or the Group By List Field Pop-Up Menu.

2)      Click on any item in the Group By List Field, then use the Clear 
Toolbar/menu option.

Drag and Drop:    There is only one Drag and Drop feature available from this field.    It is:
1)      Drag and Drop a column name from the Column Name field onto the 

Group By List Field.        Doing this will add a GROUP BY statement for the 
column name dropped to the end of the list.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
Remove From Group By Clause - Removes the column names selected in the
Group By List Field from the list.
Clear Group By Clause - Removes all column names in the Group By List Field
from the list.

See Also:



Column Name List field
Drag And Drop
Order/Group By Clause Window
Order/Group By Menu



Help Menu
The Help Menu contains selections for viewing help text on the fields and windows within 
MDS PowerBase.    It is also used to display the license agreement and an information 
window about MDS PowerBase.    The following selections are available from the menu:
Contents

This selection displays the Table Of Contents for MDS PowerBase help.
Search

This selection displays the Help Search window which allows you to search for MDS 
PowerBase help based on keywords.    For example, if you would like help on Creating 
SQL, you would enter Creating SQL in the Help Search window.    A list of all help topics 
associated with Creating SQL would then be listed.

Active Field
This selection displays help on the active field.    If no field is active, help on the active 
window will be displayed.

Active Window
This selection displays help on the active window.

Help On Using Help
This selection displays help on how to use the Windows Help Facility.    It is only available
if the Windows Help file WINHELP.HLP is installed on your PC.

Using the ODBC Administrator 
This selection displays help on using the ODBC Administrator Facility.

License Agreement
This selection displays the license agreement for using MDS PowerBase.

About
This selection displays information about MDS PowerBase including the release and 
version.    It also displays the product serial number in the window title until the product 
is registered.

See Also:
Using the Menu



Index Definition Window
Purpose:    The Index Definition Window displays the SQL that was used to create the 

index selected in the Table Indexes List field on the Table Details Window.    This 
window is only accessible using the Table Details Window.    It is an information 
only window and DOES NOT create an index.

Using:    To get to this window, double-click on one of the indexes listed in the Table 
Indexes List field on the Table Details Window.    After viewing the SQL which 
created the index, click on the OK button to close the window.



Installing ODBC
MDS PowerBase is delivered with an ODBC installation diskette.    To install ODBC perform 
the following steps:
1)      Insert the MDS PowerBase ODBC installation diskette (#2) into a disk drive.    If you are

installing from your hard disk, change directories to where the MDS PowerBase ODBC 
installation diskette (#2) was copied to.

2)      Run the ODBC setup program (SETUP.EXE)
3)      Select the ODBC drivers you want to install. MDS PowerBase delivers the ODBC drivers

for the SQL Server and Oracle database management systems.
Note:    If you install the SQL Server ODBC driver, you must install the procedures 
delivered in the file INSTCAT.SQL which is on the MDS PowerBase ODBC installation 
diskette (#2).    Each SQL Server datasource must have the procedures loaded onto the 
server.    Loading of procedures is usually done by your SQL Server Administrator.

4)      After completing the ODBC installation, you need to run the ODBC Administration 
Facility to maintain datasources.    To run the the ODBC Administration Facility use the 

ODBC Administration Facility toolbar button , or select CONFIGURE ODBC (or press 
CTRL-G) from the MDS PowerBase File menu.

See Also:
Obtaining Additional ODBC Database Drivers
ODBC Administrator Facility



License Agreement
The following license agreement applies to you if you are using MDS 
PowerBase.
This is a legal agreement between you (either an individual or an entity) and Analytical 
Solutions, Inc.    By installing and using this product you are agreeing to be bound by the 
terms of this agreement.    If you do not agree to the terms of this agreement, you are not 
authorized to use the MDS PowerBase product.

Analytical Solutions, Inc. Software License
1. GRANT OF LICENSE. (Applicable to Single User Product only)    Analytical Solutions, 
Inc. grants to you the right to use one copy of the registered software program ("the 
SOFTWARE") on a single computer.    Until the time this SOFTWARE is registered, it may be 
copied and distributed to an unlimited number of persons/entities so long as the 
SOFTWARE has not been altered.    The SOFTWARE is in "use" on a computer when it is 
loaded into temporary memory (ie. RAM) or installed into permanent memory (ie. hard 
disk) of that computer.    Installation of the SOFTWARE on a network server to enable 
multiple simultaneous "use" of the SOFTWARE requires a separate license for each 
SOFTWARE in "use".
1. GRANT OF LICENSE. (Applicable to Site Licence Product Only)    Analytical Solutions,
Inc. grants to you the right to use a limited number of copies (as specified in the site 
license agreement purchased) of the registered software program ("the SOFTWARE") within
the organization the SOFTWARE is licensed to.    The registered SOFTWARE may only be 
installed on computers owned by the persons/entities the SOFTWARE is licenced to.    Until 
the time this SOFTWARE is registered, it may be copied and distributed to an unlimited 
number of persons/entities so long as the SOFTWARE has not been altered.    The 
SOFTWARE is in "use" on a computer when it is loaded into temporary memory (ie. RAM) or
installed into permanent memory (ie. hard disk) of that computer.    If the SOFTWARE is 
installed on a network server to enable multiple simultaneous "use" of the SOFTWARE, the 
registered SOFTWARE may only be installed on computers where the multiple simultaneous
"uses" can be monitored.    In addition, the number of multiple simultaneous "uses" of the 
SOFTWARE is limited to the number of copies specified in the site license agreement 
purchased.

(Applicable to Single User Product and Site License)
2. COPYRIGHT.    the SOFTWARE is owned by Analytical Solutions, Inc. and is protected by 
United States copyright laws and international treaty provisions.    Therefore, you must treat
the SOFTWARE like any other copyrighted material except that you may (a) Copy and 
distribute the SOFTWARE freely as long as it has not been registered (thereby removing 
any limitations existing in an unregistered copy of the SOFTWARE), (b) make one copy of 
the SOFTWARE solely for backup or archival purposes.    You may not copy any of the 
printed material delivered with the SOFTWARE.
3. OTHER RESTRICTIONS.    You may not rent or lease the SOFTWARE, but you may transfer 
the SOFTWARE on a permanent basis provide you retain no copies and the recipient agrees
to the terms of this Agreement.    You may not reverse engineer, decompile, or disassemble 
the SOFTWARE.    If the SOFTWARE is an update or has been updated, any transfer must 
include the most recent update and all prior versions.

WARRANTY
LIMITED WARRANTY.    Except as provided above, Analytical Solutions, Inc. warrants that the
SOFTWARE will perform substantially in accordance with the accompanying written 
material (including online help) for a period of ninety (90) days from the date of 
installation.    Any implied warranties on the SOFTWARE are limited to ninety (90) days.    In 
states/jurisdictions that do not allow limitations on duration of an implied warranty, the 



above limitation does not apply to you.
CUSTOMER REMEDIES.    Analytical Solutions, Inc.'s entire liability and your exclusive 
remedy shall be, Analytical Solutions, Inc.'s option, either (a) return of the price paid, or (b) 
repair or replacement of the SOFTWARE that does not meet Analytical Solutions, Inc.'s 
limited warranty and which is returned to Analytical Solutions, Inc.    This Limited Warranty 
is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication.    
Any replacement SOFTWARE will be warranted for the remainder of the original warranty 
period or thirty (30) days, whichever is longer.
NO OTHER WARRANTIES.    To the maximum extent permitted by law, Analytical Solutions, 
Inc. disclaim all other warranties, either expressed or implied, including, but not limited to 
implied warranties of merchant ability and fitness for a particular purpose, with regard to 
the SOFTWARE and the accompanying written material.    This limited warranty gives you 
specific rights.    You may have others which vary from state/jurisdiction to 
state/jurisdiction.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES.    To the maximum extent permitted by law, 
in no event shall Analytical Solutions, Inc. be liable for damages whatsoever (including 
without limitation, damages for the loss of business profits, business interruption, loss of 
business information, or any other pecuniary loss) arising out of the use of or inability to 
use this Analytical Solutions, Inc. SOFTWARE, even if Analytical Solutions, Inc. has been 
advised of the possibility of such damages.    Because some states/jurisdictions do not allow
for the exclusion or limitation of liability for consequential damages, the above limitation 
does not apply to you.
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Object List Field
Purpose:    The Object List Field is located on the Referencing Objects Window which is 

only available while connected to a SQL Server datasource. It lists all SQL Server 
objects (stored procedures, triggers, and views) which reference the last table 
selected in the Table List Field.    If no table is selected, all SQL Server objects 
(stored procedures, triggers, and views) within the current datasource/database 
are listed.

Using:    When the Referencing Objects Window is first displayed, stored procedures are 
displayed.    To view different objects, click on one of the following buttons :

Procedures:    Lists stored procedures.
Triggers:    Lists triggers.
Views:    Lists views.
All:    Lists all of the above objects at the same time.

Viewing The Source of an Object
There are two ways to view the source of an object.    In each case, the SQL 
CREATE statement used to create the object is displayed.

1)      Double Click on an object in the list.    This approach will retreive the 
objects' source from the server and display it in a Query Result Window.

2)      Drag and Drop an object in the list onto a Query Window.    This 
approach will retreive the objects' source from the server and display it 
in the Query Window.    Using this approach enables you to modify the 
objects' source and re-load the object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

Printing The List Of Objects
The list of objects in the Object List field can be printed by using the Print 
selection on the Object List field Pop-Up menu.    Note that only the list is 
printed.    Not the source for each object in the list.

Drag and Drop:    The following Drag and Drop feature is available from this field: 
1)      Drag and Drop an object in the list onto a Query Window.    This will 

retreive the objects source from the server and display it in the Query 
Window.    Using this approach enables you to modify the objects' source 
and re-load the object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
Retreive Selected Object - Retreives the objects' source from the server and 
displays it in a Query Result Window.
Print - Prints the list of objects in the Object List field.    Only the list is printed.   
Not the source for each object in the list.

See Also:
Drag And Drop
Table List Field
Referencing Objects Window





Obtaining Additional ODBC Database Drivers
MDS PowerBase is delivered with ODBC drivers which support the SQL Server (Microsoft 
and SYBASE) and ORACLE database management systems.    MDS PowerBase however can 
access data in any database management system which supports the ODBC interface.
The text file ODBCDRV.TXT located in the MDS PowerBase directory contains a list of known
suppliers you can purchase ODBC drivers from for various DBMS.    Additionally, you can 
contact Microsoft Corp. or use COMPUSERVE for further information about ODBC Driver 
Suppliers.



ODBC Administrator Facility
Purpose:    This button/menu option is used to launch the ODBC Administrator Facility. The 

ODBC Administrator is used to create and manage a datasource..    Each 
datasource is identified by a unique name.
For further Information about the ODBC Administrator Facility and managing 
datasources, refer to Using the ODBC Administrator Facility.

When Active:    This button is always active.
Quick Key: None

Toolbar Button: 
Using Menu:    Configure ODBC from the File Menu
See Also:

Using the Toolbar
Using the Menu



ODBCADM.EXE Location field
Purpose:    The ODBCADM.EXE Location field is displayed on the Preferences Window.    It is

used to point to the location (directory) of the ODBC Administrator Facility 
program ODBCADM.EXE.    The ODBCADM.EXE is installed from the MDS 
PowerBase Installation Diskette #1 into the Windows Directory.    This field 
enables you to move the ODBCADM.EXE program to another directory and still 
run it from the MDS PowerBase Application.

Using:    Unless you move the program ODBCADM.EXE from the Windows directory, you 
do not need to change the information defaulted into this field.    If you do move 
the ODBCADM.EXE from the Windows directory, enter the complete path of 
where you moved the ODBCADM.EXE program to.

See Also:
Installing ODBC
ODBC Administrator Facility
Preferences Window



Open Database Connectivity (ODBC)
The Open Database Connectivity Interface is a product of Microsoft Corporation.    It is a C 
programming language which provides a standard interface to all database management 
systems which support the ODBC.
The benefits of ODBC are that applications, similar to MDS PowerBase, can be written 
independently of specific DBMS's.    Users can then add modules for a specific DBMS (called
database drivers) which enable them to access the various database management 
systems.



Open New Query Window
Purpose:    This button/menu option is used to open a new query window.    MDS 

PowerBase enables up to 10 query windows to be opened simultaneously.    Each 
query window can contain a different query which can be executed.

When Active:      This button/menu option is always enabled.    If 10 query windows are 
already in use when this button/option is selected, a message will be 
displayed stating no more query windows may be opened.    In this case, you 
will need to re-use one of the already open query windows.

Quick Key: None 

Toolbar Button: 
Using Menu:    New from the File Menu
See Also:

Creating Queries
Query Window
Using the Menu
Using the Toolbar



Open Order/Group By Window
Purpose:    This button/menu option opens up the Order/Group By Clause Window.    This 

window is used to build SQL ORDER BY and GROUP BY statements to be used 
with SQL SELECT queries.

When Active: This button/menu option is enabled if at least 1 column is selected in the 
Column List field.

Quick Key: CTRL-G 

Toolbar Button: 
Using Menu:    Order/Group By Clause from the Query Menu 
See Also:

Creating Queries
Using the Toolbar
Using the Menu



Open Preferences Window
Purpose:    This button/menu option opens up the Preferences Window.    This window is 

used to set up options and policies (preferences) that affect the way MDS 
PowerBase runs.    These preferences are normally entered the first time you run 
MDS PowerBase and are infrequently changed.

When Active: This button/menu option is always active.
Quick Key: None

Toolbar Button: 
Using Menu:    Preferences... from the File Menu 
See Also:

Using the Toolbar
Using the Menu



Open Referencing Objects Window
Purpose:    This button/menu option opens up the Referencing Objects Window.    This 

window lists all SQL Server (Microsoft and SYBASE) objects (stored procedures, 
triggers, and views) which reference the last table selected in the Table List Field. 
If no table is selected, all SQL Server objects (stored procedures, triggers, and 
views) within the current datasource/database are listed.

When Active:      This button/menu option is only active when the current datasource. is a 
SQL Server datasource.

Quick Key: CTRL-J

Toolbar Button: 
Using Menu:     Referencing Objects from the SQL Server Menu
See Also:

Object List Field
Using the Menu
Using the Toolbar



Open SQL Script Facility Window
Purpose:    This button/menu option opens up the SQL Script Facility Window.    This 

window is used to execute SQL stored in one or more text files.
When Active:      This button/menu option is active after a datasource. has been connected

to.
Quick Key: CTRL-Y

Toolbar Button: 
Using Menu:     SQL Script Facility from the File Menu
See Also:

Using the Menu
Using the Toolbar



Open Where Clause Window
Purpose:    This button/menu option opens up the SQL Where Clause Criteria Window.    

This window is used to build SQL WHERE clauses to be used with SQL SELECT 
queries.

When Active: This button/menu option is enabled if at least 1 column is selected in the 
Column List field.

Quick Key: CTRL-W 

Toolbar Button: 
Using Menu:    WHERE Clause from the Query Menu 
See Also:

Creating Queries
Using the Toolbar
Using the Menu



Order By Clause List field
Purpose:    The Order By Clause List Field is located on the Order/Group By Window.    It 

lists all the columns that will be used to build the ORDER BY clause of a SQL 
SELECT statement built using the Build SQL button/menu option.    This field has 
Extended Selection capabilities.

Using:    Prior to adding a column name to the Order By Clause List Field, you should 
select the sort sequence the column is going to be ordered in using the Order By 
Sort Sequence field.
Adding A Column Name To The List

There are two ways to add a column name to the Order By List Field (ORDER 
BY statement).    They are:

1)      Drag and Drop a column name from the Column Name field onto the
Order By List Field.    Doing this will add an ORDER BY statement for the 
column name dropped to the end of the list.

2)      Select (click on) a column name in the Column Name field.    Next 
select Add to Order By Clause from the Order/Group By menu, or from
the Pop-Up menu of the Column Name field.    This will add an ORDER BY 
statement for the column name selected to the end of the list.

Regardless of the method used, the column name field is what is 
actually added to the Order By List.    The ORDER BY statement for all 
the columns in the list is built upon selecting the Build SQL 
toolbar/menu option.

Removing A Column Name From The List
There are two ways to remove one or more column names from the Order By 
List Field (ORDER BY statement).    They are:

1)      Select (click on) one or more column names in the list.    Press the 
DELETE key on your PC.

2)      Select (click on) one or more column names in the list.    Select the 
Remove From Order By Clause menu option from the Order/Group By
Menu or the Order By List Field Pop-Up Menu.

Clearing (Removing All Column Names) The List
There are two ways to remove all the column names from the Order By List 
Field (ORDER BY statement).    They are:

1)      Select the Clear Order By Clause menu option from the Order/Group
By Menu or the Order By List Field Pop-Up Menu.

2)      Click on any item in the Order By List Field, then use the Clear 
toolbar/menu option.

Drag and Drop:    There is only one Drag and Drop feature available from this field.    It is:
1)      Drag and Drop a column name from the Column Name field onto the 

Order By List Field.        Doing this will add an ORDER BY statement for 
the column name dropped to the end of the list.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
Remove From Order By Clause - Removes the column names selected in the
Order By List Field from the list.
Clear Order By Clause - Removes all column names in the Order By List Field 



from the list.
See Also:

Column Name List field
Drag And Drop
Order/Group By Clause Window
Order/Group By Menu



Order By Sort Sequence field
Purpose:    The Order By Sort Sequence Field is located on the Order/Group By Window.    It 

is used in conjunction with the Order By List Field to create the ORDER BY clause 
of a SQL SELECT statement.    This field determines whether a column will be 
ordered in Ascending or Descending sequence.

Using:    This field has two values; Ascending and Descending.    The value selected at
the time a column is added to the Order By List Field determines whether that 
column will be ordered in Ascending or Descending sequence.
For example, if the column selected is EMPLOYEE_ID and the sort value chosen is 
Ascending, the ORDER BY statement for that column would be:
                                                    ORDER      BY      EMPLOYEE_ID      ASC

See Also:
Column Name List field
Order By Clause List field
Order/Group By Clause Window



Order/Group By Clause Window
Purpose:    The Order/Group By Clause Window is used to build SQL ORDER BY and GROUP 

BY clauses.    These clauses are used when SQL SELECT queries are built using 
the BUILD SQL toolbar/menu option.

Accessing:    The Order/Group By Clause Window can be accessed in the following ways:

1)    Use the Open Order/Group By toolbar button    .
2)    Select Order/Group By Clause from the Query Menu.

Using:    A sample flow of processing on the Order/Group By Clause Window is:
1)      Select a Column Name from the Column Name List field to add to the 

Order By or Group By list.
2)      Add the Column Name to the proper list (Order By or Group By) by 

selecting the proper menu option in the Order/Group By Menu.
3)      Repeat steps 1 and 2 until you have selected all the columns required to 

build the ORDER BY and GROUP BY clauses
4)      Build the SQL SELECT query using the BUILD SQL toolbar/menu option.    

The SQL SELECT query will include the ORDER BY and/or GROUP By clauses
built.

Fields: The following fields are located on the Order/Group By Clause Window.    Click on
the field name to view information about the field.
Column Name List field
Group By Clause list field
Order By Clause List field
Order By Sort Sequence field

See Also:
Building SQL Queries
Creating Queries
Open Order/Group By Window
Order/Group By Menu
SQL Where Clause Criteria Window



Order/Group By Menu
The Order/Group By Menu contains selections used to create SQL ORDER BY and GROUP BY
statements.    It is visible only while working on the Order/Group By Clause Window    The 
following selections are available from the menu:
Add To Order By Clause

This selection adds the column name selected in the Column Name List Field to the 
Order By Clause List field.    The sort order of the column is determined by the value of 
the Order By Sort Sequence field.

Remove From Order By Clause
This selection removes one or more column names selected in the Order By Clause List 
Field from the list.

Clear Order By Clause
This selection removes all column names from the Order By Clause List field.

Add To Group By Clause
This selection adds the column name selected in the Column Name List Field to the Group 
By Clause List field.
Remove From Group By Clause

This selection removes one or more column names selected in the Group By Clause List 
Field from the list.

Clear Group By Clause
This selection removes all column names from the Group By Clause List field.

Build SQL Statement
Builds a SQL SELECT statement using the following SQL SELECT information:

*    Selected columns from the Column List Field on the Datasources Window
*    WHERE Clause, if entered
*    ORDER BY Clause, if entered
*    GROUP BY Clause, if entered

See Also:
Creating Queries
Order/Group By Clause Window
Using the Menu
Using the Toolbar



Overview
MDS PowerBase is a SQL database front-end tool which utilizes Microsoft's Open Database 
Connectivity (ODBC) interface to access database information. It's primary purpose is to 
enable you to easily access data in virtually any Database Management System (DBMS) 
from a single tool using a common interface.    This makes MDS PowerBase unique 
compared to other tools which can only access data from a single DBMS.
For example, MDS PowerBase enables you to execute a SQL based query against a SQL 
Server DBMS, ORACLE DBMS, and Microsoft Access DBMS using the same easy to use 
interface without ever having to leave the program.
In addition, as more database vendors support the ODBC interface, additional ODBC drivers
will become available.    This will enable you to access additional DBMS's without having to 
purchase a new version of MDS PowerBase.
Look at some of the major features of MDS PowerBase:

Access to an unlimited number of ODBC compliant database management systems. 
Create multiple Queries with the ability to save and retreive the SQL created thereby 

eliminating re-entry of commonly used SQL.
Drag and Drop tables to automatically build SQL SELECT statements against the 

tables.
Drag and Drop stored procedures, triggers, and views directly from a SQL Sever 

database to view their text.
SQL Script Facility Window which enables you to easily run queries stored in one or 

more text files.
View query results in result windows or have the results automatically loaded to your 

favorite text editor 
Easily build SQL SELECT statements against one or more tables including WHERE, 

ORDER/GROUP BY, and JOIN criteria.
And Much More........

MDS PowerBase is marketed under the Shareware concept.    This means you have 30 days 
to evaluate the product free of charge.    During this time you are encouraged to duplicate 
and re-distribute the product as you received it.    If after 30 days, you'd like to continue 
using the product, the product must be registered.    Refer to the Registering MDS 
Powerbase Help Topic for information about registering the product. 
The unregistered product you are evaluating has the following limitations:

Only 1 Query window is available for entering SQL
Only 1 table can be selected at a time
Table information is unavailable
You cannot execute SQL statements from the SQL Script Facility
The SELECT ALL COLUMNS menu option which automatically builds a SQL SELECT 

statement for all columns in the column list has been disabled
All Drag and Drop features have been disabled including:

Drag and Drop of tables to automatically create SQL SELECT queries
Drag and Drop of procedures, triggers, and views to view their text
Drag and Drop of text files to execute and/or view the SQL stored within the files

Refer to the Help Topic Drag and Drop for a complete list of Drag and Drop facilities within 
MDS PowerBase.
After registering the product, all of the features within MDS PowerBase will be enabled.



Password field
Purpose:    The Password field is located on the Preferences Window.    It is used along with 

the User ID field as a default value when connecting to a datasource.
Using:    The Password field is used to save time when connecting to a datasource by 

defalting in the password entered if no previous password has been entered.    
When connecting to a datasource, the password used is determined by the 
following:

1)    If the Store Datasource Passwords field. on the Preferences Window is 
turned on, the password used will be the last one used while connecting 
to that datasource.

2)      If the Store Datasource Password field is turned off, or there was no 
previous connection to the datasource, the password used will be the 
Password used to connect to the previous datasource.

3)      If there was no previous password entered, the password used will be 
the Password entered in the Password field on the Preferences Window.

4)      If no password was entered in the Password field on the Preferences 
Window, the password will be left blank and required to be entered.

See Also:
Connecting To a Datasource



Pop Up Menu
A Pop-Up menu is a special type of menu which displays items related to a particular field.   
This makes menu navigation very easy because all of the functions for a given field are 
presented on a single menu.    For example, the Pop-Up menu for the Query Window only 
contains selections pertaining to building, executing, and saving queries.
Pop-Up menus are accessed in two ways.    While working in a given field, press the Quick 
Key combination ALT-M or click the right mouse button over the field you are working in.    
In either case, a menu will be displayed with selections applicable to the field you are 
working in.
Fields with an associated Pop-Up menu have a section in their help text labeled Pop-Up 
Menu.



Preferences Window
Purpose:    The Preferences Window is used to establish parameters which MDS PowerBase

uses to run.    The Preferences Window is usually used when MDS PowerBase is 
first installed.    After that, the parameters on this window are rarely changed.

Accessing:    The Preferences Window can be accessed in the following ways:
1)    Use the Open Preferences toolbar button    .

2)    Select Preferences... from the File Menu
Fields:    The following fields are located on the Preferences Window.    Click on the field 

name to view information about the field.
Auto Execute Query field
Display Query Results In field
ODBCADM.EXE Location field
Password field
Query Timeout field
Show System Tables field
Store Datasource Passwords field
Text Editor field
Use Separate Query Result Windows field
User ID field



Query Menu
The Query Menu contains selections used to create, execute, and save SQL Queries.    It is 
visible only while working on windows associated with one of the above tasks.    The 
following selections are available from the menu:
Set Rowcount

This selection presents a window that enables you to limit the number of rows returned 
in the result set of a query.    The number of rows to be returned is displayed in the 
Status Bar and is controlled by the ROWCOUNT parameter.
If all rows are to be displayed, the status bar will display the value ALL ROWS.    If the 
number of rows has been limited, the status bar will display the number of rows to be 
returned.

Distinct
This selection determines whether the SQL SELECT query built using the Build SQL will 
be built as SELECT DISTINCT or not.    If this value is checked, the SQL SELECT query will 
be built as SELECT DISTINCT.    If this value is not checked, the SQL SELECT query will 
be built as SELECT.

Select All Columns
This selection selects all columns in the Column List field on the Datasources Window 
and builds a SQL SELECT query using all the selected columns.

Build SQL Statement
Builds a SQL SELECT statement using the following information:

*    Selected columns from the Column List Field on the Datasources Window
*    WHERE Clause, if entered
*    ORDER BY Clause, if entered
*    GROUP BY Clause, if entered
*    DISTINCT if selected on the Query Menu

Where Clause
This selection displays the SQL Where Clause Criteria Window which is used to build a 
WHERE clause for a SQL SELECT query.

Order/Group By Clause
This selection displays the Order/Group By Clause Window which is used to build an 
ORDER BY and/or GROUP BY clause for a SQL SELECT query.

Run Query
This selection is used to execute the SQL in the current Query Window.    The current 
query window is considered the query window that the cursor is currently in.    This 
selection is usually used after entering SQL manually or creating SQL using the Build 
SQL button/menu selection.

Execute SQL In Selected Files
This selection executes the SQL within the files selected in the File List field on the SQL 
Script Facility Window.

See Also:
Creating Queries



Using the Menu
Using the Toolbar



Query Result Window
Purpose:      MDS PowerBase uses the Query Result Window to display the results of 

queries that are run.    Query results are only displayed in a Query Result window 
if the Display Query Results In field on the Preferences Window is set to WINDOW.
Otherwise, query results are displayed within a text editor.

Accessing:    Only MDS PowerBase can open a Query Result Window.    However, you can 
quickly locate the last used Query Result window by pressing the Quick Key 
CTRL-R.    You can also access the last used Query Result window using the 
Windows Menu.
Up to 10 Query Result windows can be opened at one time.    This is controlled 
by the Use Separate Query Result Windows field on the Preferences Window.    If
this field is turned off, each new query result will overlay the result of the 
previously run query.

Pop Menu:    The following selections are on the Pop Up Menu for this window:
Save - This selection saves the text in the Query Result Window into a file.
Close - This selection closes the Query Result Window.
Find - This selection displays a window to be used for locating text within the 
Query Result Window.
Find Next - This selection finds the next location of the text being searched for
within the Query Result Window.    It assumes the FIND selection had been 
previously made.
Find Previous - This selection finds the previous location of the text being 
searched for within the Query Result Window.    It assumes the FIND selection 
had been previously made.
Clear - This selection clears (erases) the text from the Query Result Window.
Cut - This selection cuts (deletes) the selected (hilighted) text from the Query 
Result Window and copies it to the Windows Clipboard.
Copy - This selection copies the selected (hilighted) text in the Query Result 
Window to the Windows Clipboard.
Paste - This selection copies text from the Windows Clipboard to the Query 
Result Window .    The text is inserted where the cursor is within the window.

See Also:
Auto Execute Query field
Clear Window Toolbar Button
Find Next
Find Previous
File Save Toolbar Button
Running a Query
Search Criteria Window
Using the Menu
Using the Toolbar



Query Timeout field
Purpose:    The Query Timeout field is located on the Preferences Window.    It is used to 

specify the number of seconds MDS PowerBase should wait for a query to 
execute.

Using:    The number entered in this field is used to limit the amount of time MDS 
PowerBase waits to hear back from the datasource when a query is run.    It is 
used to prevent a situation in which a query is sent to a datasource, but the 
datasource does not communicate with MDS PowerBase for a long period of time.
In this situation, your PC would be locked up waiting for the datasource to return 
contol to MDS PowerBase.    By specifying a limit in this field, MDS PowerBase is 
ensured to get control back after the number of seconds specified.
An acceptable number of seconds to wait is different for each person.    However 
a number between 15 - 30 seconds is usually sufficient to let most queries 
execute successfully.
You should note, that once the datasource communicates with MDS PowerBase, 
the timeout limit is no longer in effect.    The result set of a query does not have 
to be fully processed in the time limit set. 

See Also:
Run Query



Query Window
Purpose:      The Query Window is used to build and run queries.    There are various ways 

to create queries within MDS PowerBase.    Refer to the Help topic Creating 
Queries for a list of ways to create queries within MDS PowerBase.

Accessing:    Query Windows can be accessed in the following ways:
Opening a New Query Window:

Select the Open Query Window toolbar button        or 
Select New from the File Menu

Accessing an Existing Query Window:
Select Query from the Windows Menu    or 
Use the Quick Key CTRL-Q

Up to 10 Query Windows can be opened at one time.    If an attempt is made to 
open more than 10 Query Windows, an error message will be displayed.

Pop Menu:    The following selections are on the Pop Up Menu for this window:
Open - This selection opens a file and loads it's text into the Query Window.
Save - This selection saves the text in the Query Window into a file.
Close - This selection closes the Query Window.
Clear - This selection clears (erases) the text from the Query Window.
Cut - This selection cuts (deletes) the selected (hilighted) text from the Query 
Window and copies it to the Windows Clipboard.
Copy - This selection copies the selected (hilighted) text in the Query Window 
to the Windows Clipboard.
Paste - This selection copies text from the Windows Clipboard to the Query 
Window .    The text is inserted where the cursor is within the window.
Set Rowcount - This selection presents a window that enables you to limit the 
number of rows returned in the result set of a query.    The number of rows to be
returned is displayed in theStatus Bar and is controlled by the ROWCOUNT 
parameter.
Distinct - This selection determines whether the SQL SELECT query built using 
the Build SQL toolbar/menu option will be built as SELECT DISTINCT or not.    If 
this value is checked, the SQL SELECT query will be built as SELECT DISTINCT.
If this value is not checked, the SQL SELECT query will be built as SELECT.
Select All Columns - This selection selects all columns in the Column List field
on the Datasources Window and builds a SQL SELECT query using all the 
selected columns.
Build SQL statement - Builds a SQL SELECT statement using the following 
information:
    *      Selected columns from the Column List Field on the Datasources Window
    *      WHERE Clause, if entered
    *      ORDER BY Clause, if entered
    *      GROUP BY Clause, if entered
    *      DISTINCT if selected on the Query Menu



WHERE Clause - This selection displays the SQL Where Clause Criteria Window
which is used to build a WHERE clause for a SQL SELECT query.
Order/Group By Clause - This selection displays the Order/Group By Clause 
Window which is used to build an ORDER BY and/or GROUP BY clause for a SQL 
SELECT query.
Run Query - This selection is used to execute the SQL in the current Query 
Window.    This selection is usually used after entering SQL manually or creating 
SQL using the Build SQL button/menu selection.

Drag and Drop:    The following Drag and Drop features are available on this window :
1)      Drag and Drop the table name from the Table List Field on the 

Datasources Window onto a Query Window.    Doing this will create a SQL
SELECT query selecting all columns in the table dropped.    If you want 
the SELECT statement to be built as a DISTINCT query, select DISTINCT 
from the Query Menu prior to dragging and dropping the table.

2)      Drag and Drop a file from the Files List field on the SQl Script Facility 
Window onto a Query Window to load the text within the file into the 
Query Window.

3)      Drag and Drop an object in the Object List Field on the Referencing 
Objects Window onto a Query Window.    This will retreive the objects 
source from the server and display it in the Query Window.    Using this 
approach enables you to modify the objects' source and re-load the 
object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

4)      Drag and Drop a SQL Server Default or SQL Server Rule from the 
Column Details Window onto a Query Window.    This will retreive the 
objects source from the server and display it in the Query Window.    
Using this approach enables you to modify the objects' source and re-
load the object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

5)      Drag and Drop a    SQL Server Table Trigger from the Table Details 
Window onto a Query Window.    This will retreive the objects source from
the server and display it in the Query Window.    Using this approach 
enables you to modify the objects' source and re-load the object to the 
server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

See Also:
Add WHERE Clause
Build SQL
Open New Query Window
Query Menu



Quick Key
Quick Key is a term used to describe one or more simultaneous keyboard keystrokes.    For 
example, the quick key CTRL-G means to press the CTRL keyboard key and while it is still 
pressed, press the G keyboard key.    Both the CTRL and G keys will be pressed at the same
time.



Referencing Objects Window
Purpose:    The Referencing Objects Window is only available while connected to a SQL 

Server (Microsoft and SYBASE) datasource.    It lists all SQL Server objects (stored 
procedures, triggers, and views) which reference the last table selected in the 
Table List Field.    If no table is selected, all SQL Server objects (stored procedures,
triggers, and views) within the current datasource/database are listed.

Accessing:    The Referencing Objects Window can be accessed in the following ways:
1)    Use the Open Referencing Objects Window toolbar button    

2)    Select Referencing Objects from the SQL Server Menu
Using:    When the Referencing Objects Window is first displayed, stored procedures are 

displayed.    To view different objects, cliick on one of the following buttons :
Procedures:    Lists stored procedures.
Triggers:    Lists triggers.
Views:    Lists views.
All:    Lists all of the above objects at the same time.

Viewing The Source of an Object
There are two ways to view the source of an object.    In each case, the SQL 
CREATE statement used to create the object is displayed.

1)      Double Click on an object in the Object List field.    This approach will 
retreive the objects source from the server and display it in a Query 
Result Window.

2)      Drag and Drop an object in the Object List field onto a Query Window.   
This approach will retreive the objects source from the server and 
display it in the Query Window.    Using this approach enables you to 
modify the objects' source and re-load the object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

Printing The List Of Objects
The list of objects in the Object List field can be printed by using the Print 
selection on the Object List field Pop-Up menu.    Note that only the list is 
printed.    Not the source for each object in the list.

Fields:    The following fields are located on the Referencing Objects Window.    Click on 
the field name to view information about the field.
Object List Field

Drag and Drop:    The following Drag and Drop feature is available from this window: 
1)      Drag and Drop an object in the Object List field onto a Query Window.   

This will retreive the objects source from the server and display it in the 
Query Window.    Using this approach enables you to modify the objects' 
source and re-load the object to the server.
Note: Prior to re-loading the objects' source you will need to add a 
DROP statement to DROP the object before it is re-loaded.

Pop Menu:    The following selections are on the Pop Up Menu for this window:
Retreive Selected Object - Retreives the source for the object selected in the
Object List Field from the server and displays it in a Query Result Window.



See Also:
Creating Queries
Drag And Drop



Registering MDS Powerbase
MDS PowerBase is distributed under the Shareware concept.    This means that you may 
use the the product free of charge for 30 days.    You are also encouraged to duplicate and 
re-distribute the product as you received it to your friends and co-workers.    If after 30 
days, you'd like to continue using this product, you must register the product.
To register the product, fill out the registration form delivered with the product 
(REGISTER.TXT) along with the registration fee.    It is important to write down the serial 
number of your product in the approriate place on the registration form.    The product 
cannot be registered without this number.
You will receive back a registration number which will be used to register the product.    You 
register the product using the MDS PowerBase Registration Program (REGISTER.EXE).    This
facility will require you to enter the registration number you received along with the name 
of the person the product is to be registered to.
Upon registering the product, all features within MDS PowerBase will be fully functional.    In
addition, the name of the person the product is registered to will be displayed each time 
MDS PowerBase is run.
See Also:

License Agreement



Registration Number Field
Purpose:    The Registration Number Field is located on the MDS PowerBase Registration 

Window.    In this field you enter the registration number sent to you when you 
register the product.    Upon registering the product, all features within MDS 
PowerBase will be fully functional.    In addition, the name of the person the 
product is registered to will be displayed each time MDS PowerBase is run.

See Also:
Registering MDS Powerbase



ROWCOUNT
Purpose:    The ROWCOUNT parameter is a selection on the Query Menu and Query Pop-Up

menu.    It is used to limit the number of rows returned in a result set of a query.    
If the ROWCOUNT parameter is not used, all the rows in a result set will be 
returned.
For example, if a table contains 100 people named SMITH, but you only wanted 
to see the first 10, you would set the ROWCOUNT parameter to 10.
The ROWCOUNT parameter is only used when a query is run.    Once the 
ROWCOUNT parameter is set, it remains set until it is changed again.

Using:    Returning All Rows In A Result Set
To return all rows in a result set select Set Rowcount from the Query Menu.    
In the Rowcount field on the Rowcount Parameter Window, enter the number 
zero (0) and press the OK button.    The Number Of Rows To Retreive section in 
the Status Bar should read ALL ROWS.

Returning A Limited Number Of Rows In A Result Set
To limit the number of rows returned in a result set select Set Rowcount from
the Query Menu.    In the Rowcount field on the Rowcount Parameter Window, 
enter the number of rows you want retreived and press the OK button.    The 
Number Of Rows To Retreive section in the status bar should display the 
number of rows to be returned.

See Also:
Running a Query
Query Menu
Using the Menu



Run DOS Shell
Purpose:    This button/menu option runs a DOS session within a window.    It is similar to 

running a DOS session from the Windows Program Manager.
When Active: This button/menu option is always active.
Quick Key: None

Toolbar Button: 
Using Menu:    DOS Shell from the File Menu 
See Also:

Using the Toolbar
Using the Menu



Run Query
Purpose:    This button/menu option is used to execute the SQL in the current Query 

Window.    The current query window is considered the Query Window that the 
cursor is currently in.    This button/menu option is usually selected after entering 
SQL manually or creating SQL using the Build SQL button/menu selection.
Upon selecting this button/menu option the following will occur:

1)      The SQL in the Query Window executed.
2)      The Cancel Query Window is displayed.    To cancel the query at anytime, 

press the Cancel button on the Cancel Query Window.    The execution of 
the query will be cancelled and only the result set(s) returned prior to the 
cancellation will be displayed.

3)      If the query being executed does not run within the timeout expiration 
period specified by the Query Timeout field an error will occur.

4)      If the query being executed returns one or more result sets, the Status 
Bar will display the number of rows being returned in the result set(s).
The number of rows returned can be limited by using the 
ROWCOUNT menu selection on the Query Menu.

5)      The result set(s), if any, are displayed either in a query window or text 
editor (based on the value of the Display Query Results In field.    The 
Preference field Use Separate Query Result Windows field will determine 
whether more than one Query Result Window is displayed, or if one is 
already displayed, will it be re-used.
The number of rows processed is displayed at the end of the Query Result 
Window and in the Comments section of the status bar.

When Active:    This button/menu option is active only when there is text in the current 
Query Window.    The red traffic light means that there is no SQL query to be 
executed.    The green light means that there is a SQL query that can be 
executed.

Quick Key: CTRL-E

Toolbar Button: 
Using Menu:    Run Query from the Query Menu
See Also:

Auto Execute Query field
Build SQL
Creating Queries
Query Menu
Query Result Window
Query Window
The ROWCOUNT Parameter
Using the Menu
Using the Toolbar



Run Text Editor
Purpose:    This button/menu option is used to run the text editor specified in the Text 

Editor field on the Preferences Window.    Selecting this option will run/launch the 
editor.    If no editor is specified in the Text Editor Preferences field, an error 
message will be displayed.

When Active: This button/menu option is always active.
Quick Key: CTRL-H

Toolbar Button: 
Using Menu:     Launch Editor from the File Menu 
See Also:

Drag And Drop
Using the Toolbar
Using the Menu



Search Criteria Window
Purpose:    The Search Criteria Window is used to Find text within a Query Result Window.   

It's main function is to enter the parameters used to locate the text (ie. text to 
locate, search direction) and initiate the search.    The Search Criteria Window is 
the first step in the search process.    It works in conjunction with the Find Next 
and Find Previous menu selections.

Accessing:    The Search Criteria Window can be accessed by selecting Find from the Edit 
Menu.    It is only available while working within a Query Result Window.

Using:    To search for text within a Query Result Window, perform the following:
1)      Enter the text to search for in the Search For field.
2)      Select whether the Search Direction will be Forward or Backward.    The 

search will begin at the current cursor position within the Query Result 
Window.

3)      Check the Match Case box if you want the text being searched for to 
match exactly the text you entered in the Search For field.    For example, 
if you check this box, the text MIKE within the Query Result Window would 
not match the Search For text Mike.    The text would have to match 
exactly if this box is checked.

4)      Press the Search button to begin the search.    If you want to cancel the 
search, press the Close button instead.

5)      After the initial search has completed, you can continue to search for the 
same text in either a forward or backward direction by using the Find Next
and Find Previous selections.



Shareware
Shareware is a concept by which you receive and evaluate software before purchasing it.    
The standard evaluation period lasts 30 days    in which you may use the product free of 
charge.    You are also encouraged to duplicate and re-distribute the product to friends, co-
workers, and bulletin boards.    If after 30 days, you'd like to continue using a shareware 
product, you must register the product.



Show System Tables field
Purpose:    The Show System Tables field is displayed on the Preferences Window.    It is 

used to control whether or not datasource system tables are displayed in the 
Table List Field on the Datasources Window.    System tables are special tables 
which are used by a datasource to manage the various resources within the 
datasource.
For example, in a SQL Server datasource there is a system table named 
SYSOBJECTS which is used to manage all the objects (tables, procedures, 
triggers, etc.) within the datasource.

Using:    If box is checked: A datasources system tables will be displayed in the Tables
List field.
If box is not checked: A datasources system tables will not be displayed in the 
Tables List field.
Note: Changing this field will cause the table list field to be re-populated.

See Also:
Preferences Window



SQL Script Facility Window
Purpose:    The SQL Script Facility Window is used to execute SQL stored in one or more 

text files.    For example, if you have a number of queries that you run each day, 
you could save the queries in one or more files.    Then using the SQL Script 
Facility Window, you could list and select each of the files from the Files List.    
After selecting the files from the list, you could easily execute the queries in each

of the files selected by pressing the Execute SQL Script toolbar button      .    
This approach is alot simpler than executing each query separately.
Because the results of all the queries executed are stored and displayed, the SQL
Script Facility can also be used as a job scheduler type utility.    For example, 
select all the files with the queries you want to execute, then press the Execute 
SQL In Selected Files button and go to lunch.    When you get back each of the 
queries would have been run and the results would be displayed on your PC 
waiting to be reviewed.
Another good use for the SQL Script Facility is to perform routine database 
maintenance.    For example, in a SQL Server environment you may store all the 
source for your stored procedures and triggers in text files.    Anytime you need to
make a change to one of these objects you could use the SQL Script Facility to 
list the text files, load the text into a text editor, change the source, save it , and 
re-load the source.

Accessing:    The SQL Script Facility Window can be accessed in the following    ways:
1)    Use the Open SQL Script Facility Window toolbar button    

2)    Select SQL Script Facility from the File Menu
3)    Use the Quick Key CTRL-Y

Using:    When the SQL Script Facility Window is first opened, the Files List will display all
files within the current drive/directory with the extension SQL.    By changing the 
Drive, Directory, or File Type, a different list of files can be displayed.
Viewing The Text Within Files

There are three ways to view the text within a file in the Files List.    They are:
1)      Double Click on a file in the list.
2)      Drag and Drop a file from the list onto the Text Editor toolbar button.
3)      Select a file from the list, then click on the Text Editor toolbar button 

or select Launch Editor from the File Menu.
Executing SQL Queries Stored Within The Files

There are two ways to execute the SQL queries stored within the files listed in 
the Files List.    They are:

1)      Drag and Drop a file from the list onto the Execute SQL Script toolbar 

button    .
2)      Select a file from the list, then click on the Execute SQL Script    toolbar button or select 
Process SQL In Selected Files from the Query Menu.

Fields:    The following fields are located on the SQL Script Facility Window.    Click on the
field name to view information about the field.
Directories List field
Drives List field



Files List field
File Types List field

Drag and Drop:    The following Drag and Drop features are available from this window: 
1)      Drag and Drop a file from the File List onto the Execute SQL Script 

toolbar button to execute the SQL query within that file.
2)      Drag and Drop a file from the File List onto the Text Editor toolbar 

button to load the text within the file into the text editor specified in the 
Text Editor field on the Preferences Window.

3)      Drag and Drop a file from the File List onto a Query Window to load the
text within the file into the Query Window.

See Also:
Drag And Drop
Exceute SQL Script
Using the Menu
Using the Toolbar



SQL Server Database Window
Purpose:    The SQL Server Database Window is used to connect (change) to a different 

database within the active SQL Server datasource.    This has the same effect as 
using the USE <database> SQL statement which also will change the current 
database.

Accessing:    The SQL Server Database Window is accessed by selecting Change 
Database from the SQL Server Menu.

Using:    There are two ways to change the current database while on this window.    
They are:

1)      Select a database from the list presented.    Next click on the Connect 
button.

2)      Double-click on a database in the list presented.    This will 
automatically connect to the database selected.

Regardless of the method used to change the database, the Table List Field will 
be re-populated with the tables in the selected database.
If you do not want to change the database, press the Cancel button.    This will 
keep you in the database currently being used.



SQL Server Default field
Purpose:    The SQL Server Default field is located on the Column Details Window.    It is 

used only with a SQL Server datasource and displays the name of the SQL Server
Default that is bound to the column being displayed.    A Default causes SQL 
Server to automatically supply a value for the column if a value is not supplied by
the user.

Using:    The SQL Server Default is an informational field that may not be changed.    The
source of the Default can however by viewed by dragging and dropping the 
default to a Query Window.    This will cause the source for the Default to be 
retreived and displayed within the Query Window.

Drag and Drop:    There is only one Drag and Drop feature available from this field.    It is:
1)    Drag and Drop the Default from the SQL Server Default field onto a 

Query Window.    Doing this will cause the source for the Default to be 
retreived and displayed within the Query Window.

See Also:
Drag And Drop
Creating Queries



SQL Server Menu
The SQL Server Menu contains selections used to retreive information from a SQL Server 
(Microsoft and SYBASE) datasource.    It is visible only while connected to a SQL Server 
datasource.    The following selections are available from the menu:
Referencing Objects

This selection displays the Referencing Objects Window.    This window lists all SQL 
Server objects (stored procedures, triggers, and views) which reference the last table 
selected in the Table List Field.    If no table is selected, all SQL Server objects (stored 
procedures, triggers, and views) within the current datasource/database are listed.

Change Database
This selection displays the SQL Server Database Window which is used to connect to a 
different database within the same datasource.    This is a quicker approach than using 
the Connect To Datasource toolbar/menu option to just change the database.

SET Options
This selection is used to SET various options within SQL Server.    It presents a sub-menu 
with the following selections.    When the selection is checked, it is ON.    If it is 
unchecked, it is OFF.    Choosing one of the selections switches it's state to ON or OFF 
depending on it's current state.

Reset Options:    This selection resets all options back to their original state (default 
value).    It does not have a check mark next to it.
ARITHMETIC ABORT:    When ON, causes a query to abort if a divide by zero or 
overflow condition occurs.    The default value is OFF.
NOEXEC:    When ON, causes a query to go through all steps up to compilation, but 
does not execute the query.    It is often used with the SHOWPLAN option to determine
the execution plan generated for a query.    Once NOEXEC is turned on, no other 
statements are executed including other SET commands until the NOEXEC option is 
turned off.    The default value is OFF.
NOCOUNT:    When ON, causes the SQL Server message displayed at the end of each
query statement execution indicating the number of rows affected by the statement 
to be suppressed.    The default value is OFF.
PARSEONLY:    When ON, causes a query to be parsed for syntax and semantic 
correctness only.    Optimization, compilation, and execution of the query does not 
occur.    The default value is OFF.
ROWCOUNT:    The ROWCOUNT option is used to limit the number of rows returned 
in a result set of a query.    If the ROWCOUNT parameter is not used, all the rows in a 
result set will be returned.    The default value is return all rows.    See also 
ROWCOUNT.
SHOWPLAN:    When ON, displays the query execution plan generated by SQL 
Server's cost-based optimizer.    The execution plan displays the exact plan the 
optimizer uses to process the query.    Once the plan is created, it is executed unless 
the NOEXEC option is ON.    The default value is OFF.
STATISTICS IO:    When ON, displays the number of table scans, number of logical 
reads, number of physical reads, and the total number of pages written during a 
queries execution.    The default value is OFF.
STATISTICS TIME:    When ON, displays the time for parsing, compiling, and 
executing queries.    This can be used in conjunction with the SHOWPLAN option to 
determine why a query may be taking a long time to execute.    The default value is 



OFF.
Queries

This selection is used to run various predefined queries against SQL Server system 
tables.    The following queries are available:

TABLES
COLUMN DETAILS FOR CURRENT TABLE
DATABASES
ACTIVE PROCESSES
LOCKED PROCESSES
DEFAULT CONFIGURATION OPTIONS
CURRENT CONFIGURATION OPTIONS
USERS
GROUPS
LOGINS



SQL Server Rule field
Purpose:    The SQL Server Rule field is located on the Column Details Window.    It is used 

only with a SQL Server datasource and displays the name of the SQL Server Rule 
that is bound to the column being displayed.    A Rule causes SQL Server to 
validate the values entered into a field are valid values.
For example, if the valid values for the column EMPLOYEE_SEX are "M" and "F", a 
rule could be created to ensure that only one of these two values are stored in 
the column.

Using:    The SQL Server Rule is an informational field that may not be changed.    The 
source of the Rule can however by viewed by dragging and dropping the rule to a
Query Window.    This will cause the source for the Rule to be retreived and 
displayed within the Query Window.

Drag and Drop:    There is only one Drag and Drop feature available from this field.    It is:
1)      Drag and Drop the Rule from the SQL Server Rule field onto a Query 

Window.    Doing this will cause the source for the Rule to be retreived 
and displayed within the Query Window.

See Also:
Drag And Drop
Creating Queries



SQL Where Clause Criteria Window
Purpose:    The SQL Where Clause Criteria Window is used to build SQL WHERE clauses.    

These clauses are used when SQL SELECT queries are built using the BUILD SQL 
toolbar/menu option.

Accessing:    The SQL Where Clause Criteria Window can be accessed in the following 
ways:
1)    Use the Open Where Clause toolbar button    .

2)    Select Where Clause from the Query Menu.
Using:    A sample flow of processing on the SQL Where Clause Criteria Window is:

1)      Select a column from the Column Name List field.    The column 
selected will be used on the left side of the comparison type field.    For 
example, if you wanted to create the WHERE statement :

                          WHERE    USER_ID    =    "JOHN"
USER_ID would be the column name you would select from the Column 
Name List.

2)      Select a comparison type from the Comparison List field.    This field 
lists various comparison operators such as Equals, Greater Than, and 
Less Than.    In our above example, the comparison type would be 
Equals.

3)      Enter a value in the Column Value field .    It is the value to which the 
selected column will be compared.    In our above example, the value 
entered would be JOHN.

4)      Select a value from the AND/OR Selection field if the WHERE Clause is 
going to consist of multiple statements.    The following is an example of 
a multiple statement WHERE Clause:
WHERE    USER_ID    =    "JOHN"    AND    STATE = "GA"

5)      Choose the Add to WHERE Clause toolbar/menu selection.    This will 
add the WHERE Statement to the end of the WHERE Clause List.

6)      Repeat steps 1-5 until all the WHERE Clause statements have been 
added to the WHERE Clause List field.    Then select the Build SQL 
toolbar/menu selction to create the SQL SELECT query with the WHERE 
Clause appended to it.

Fields:    The following fields are located on the SQL Where Clause Criteria Window.    
Click on the field name to view information about the field.
And/Or Selection field
Column Name List field
Column Value field
Comparison List field
Where Clause List field

See Also:
Building SQL Queries
Creating Queries
Open Where Clause Window



Order/Group By Clause Window
Using the Menu
Using the Toolbar
WHERE Clause Menu



Status Bar
The status bar is located underneath the toolbar and displays various information about the
processing occurring within MDS PowerBase.
Click on a section of the status bar to view what information is displayed in it.



Store Datasource Passwords field
Purpose:    The Store Datasource Passwords field is located on the Preferences Window.    It

is used when connecting to a datasource and controls whether the password 
used to connect to the datasource will be stored in the ODBC.INI file.
Storing the password with the datasource will reduce the amount of data entry 
required to connect to a datasource because the password field will already be 
filled in for you when you connect to the datasource.    There is however a 
security issue with storing the password because now anyone who uses your 
computer will be able to connect to the datasource as you without having to 
enter your password.
When connecting to a datasource, the password used to connect to the 
datasource is determined by the following:

1)      If the Store Datasource Passwords field. on the Preferences Window is 
turned on, the password used will be the last one used while connecting 
to that datasource.

2)      If the Store Datasource Password field is turned off, or there was no 
previous connection to the datasource, the password used will be the 
Password used to connect to the previous datasource.

3)      If there was no previous password entered, the password used will be 
the Password entered in the Password field on the Preferences Window.

4)      If no password was entered in the Password field, the password will be 
left blank and required to be entered.

Using:    If box is checked: Passwords will be stored in the ODBC.INI file along with the 
datasource information.
If box is not checked: Passwords will not be stored in the ODBC.INI file along 
with the datasource information.

See Also:
Connecting To a Datasource



serial number
The MDS PowerBase serial number is a unique number identifying your copy of MDS 
PowerBase.    You will use it to register the product.    The serial number can be found in the 
window title of the About MDS PowerBase Window which is accessed from the Help 
Menu    The serial number is also displayed on the MDS PowerBase Registration window.
See Also:

Registering MDS Powerbase



Table Columns List field
Purpose:    The Table Columns List field is located on the Table Details Window.    It lists 

information for all columns in the table displayed.    The following information is 
displayed for each column:

Column Name
Column Type (CHAR, MONEY, etc.)
Column Size

Using:    The Table Columns List field is an information only field.    None of the values 
within it can be changed.    To view more detailed information about a 
column, double-click on the row of a column.    This will display the Column 
Details Window showing information about the column.

See Also:
Table Indexes List field



Table Details Window
Purpose:    The Table Details Window is used to display the following information about a 

table:
Table Name
Number Of Rows In the Table
Information about the columns in the table including:

Column Name
Column Type (CHAR, MONEY, etc.)
Column Size
Can the column have NULL values:

Not Null :    Column cannot have NULL values
Null :                      Column can have NULL values

Information about the indexes of the table including:
Index Name
Columns in the index
Whether the index is UNIQUE or NONUNIQUE
Whether the index is CLUSTERED or NONCLUSTERED

USED WITH SQL SERVER DATABASES ONLY:
SQL Server Triggers Associated with the table

Accessing:    The Table Details Window can be accessed in the following ways using the 
Table List Field on the Datasources Window:

1)      Double Click on a table name
2)      Click on table name then select the TABLE DETAILS menu option on

the Datasources Menu or the Pop Menu.
Using:    The Table Details Window is an information only window.    None of the values 

displayed can be changed.    However, the following processing is avaialbel on 
the window:
Viewing more detailed information about a column
To view further information about a column, doubleclick on the row of a Table 
Column List field.    This will display the Column Details Window showing 
information about the column.
Viewing the SQL CREATE statement used to build an index
To view the SQL CREATE statement used to build an index, doubleclick on the row
of an index in the Table Index List field.    This will display the Index Definition 
Window showing the SQL CREATE statement used to build the index selected.

Drag and Drop: The following Drag and Drop operations may be performed from this 
window:
Any of the SQL Server Triggers may be dragged and dropped onto a Query 
Window.    The source for the trigger is then retrieved and displayed within 
the Query Window.

Fields:    The following fields are located on the Table Details Window.    Click on the field
name to view information about the field.
Table Columns List field
Table Indexes List field

See Also:



Datasources Menu
Drag and Drop
Pop Up Menu



Table Indexes List field
Purpose:    The Table Indexes List field is located on the Table Details Window.    It lists all 

of the indexes for the table displayed.    The following information is displayed for 
each index:

Index Name
Columns in the index
Whether the index is UNIQUE or NONUNIQUE
Whether the index is CLUSTERED or NONCLUSTERED

Using:    The Table Indexes List field is an information only field.    None of the values 
within it can be changed.    To view the SQL CREATE statement that built an 
index, doubleclick on the row of an index.    This will display the Index Definition 
Window showing the SQL CREATE statement used to build the index selected.

See Also:
Table Columns List field



Table List Field
Purpose:    The Table List field displays the tables and views within the 

datasource/database connected to.    If the Show System Tables field on the 
Preferences Window is selected, the table list will contain the system tables 
within the datasource.    During the rest of this discussion, the term TABLE will be 
used to refer to both a Table and a View within the Table List Field.

Using:    The table list field is primarily used to list the columns of a table within the 
Columns List field.    These columns are then used to build SQL SELECT Queries.    
For further information about building SQL SELECT Queries refer to Creating 
Queries.
Selecting/Deselecting a Table

To select a table, click on the table name.    The table should now be selected
(hilighted).    To deselect a table click on the hilighted table.    The table will 
no longer be hilighted.

Deselecting All Tables in the list
To quickly deselect all tables in the table list doubleclick on the 
Tables/Views button  above the 
table list field.

Viewing Table Information
To view information about a table, doubleclick on a table name.    This will 
display the Table Details Window.

Pop Menu:    The following selections are on the Pop Up Menu for this field:
Table Details - Displays Table Details for the last selected table.    These 
include the columns within the table, triggers for the table, and indexes for the 
table.
Print - Prints the information displayed in the Tables Detail Window for the each
of the tables selected in the Table List.

Drag and Drop:    There is only one Drag and Drop feature available from this field.    It is:
1)      Drag and Drop the table name from the Table List onto a Query 

Window.    Doing this will create a SQL SELECT query selecting all 
columns in the table dropped.    If you want the SELECT statement to be 
built as a DISTINCT query, select DISTINCT from the Query Menu prior to 
dragging and dropping the table.

See Also:
Datasources Window
DISTINCT Parameter
Drag And Drop



Text Editor field
Purpose:    The Text Editor field is located on the Preferences Window.    It is used define a 

text editor that can be used to load query results into.    The text editor is also 
used to load and edit SQL scripts.    The text editor can also be launched using 

the Text Editor toolbar button        or menu selection.
The text editor field is used in conjunction with the Display Query Results In field. 
If this field is set to TEXT EDITOR, query results will be loaded into the text editor 
defined in this field.
The default editor specified at installation time is the Windows Notepad.    If no 
text editor is entered in this field, all of the above uses of the text editor will 
result in an error occurring.

Using:    Enter the full path of the text editor you want to use in this field.    For example,
if your text editor is located in the C:\WINDOWS directory and is named 
MYEDIT.EXE, the value C:\WINDOWS\MYEDIT.EXE should be entered in the text
editor field.

See Also:
File Menu
Using the Toolbar



Use Separate Query Result Windows field
Purpose:    The Use Separate Query Result Windows field is located on the Preferences 

Window.    It is used in conjunction with the Display Query Results In field to 
display query results within an MDS PowerBase Query Result Window.    If this 
field is selected, up to 10 concurrent Query Result Windows will be used to store 
the results of queries run.    This enables you to compare the results of multiple 
queries.
If the Display Query Results In field is set to TEXT EDITOR, this field will be 
disabled and has no effect on the displaying of query results.

Using:    If box is checked: The results of each query run will be stored in a separate 
Query Result Window.    Up to 10 separate query result windows will be used.    If 
there are 10 Query Result Windows open at one time, the first Query Result 
Window will be re-used.
If box is not checked: Query Results will be displayed within a single query 
result window.    Each query that is run will overlay the results of the previously 
run query.

See Also:
Query Result Window
Running a Query



User ID field
Purpose:    The User ID field is located on the Preferences Window.    It is used along with 

the Password field as a default value when connecting to a datasource.
Using:    The User ID is used to save time when connecting to a datasource by defalting 

in the User ID if no previous User ID has been entered.    When connecting to a 
datasource, the User ID used to connect to the datasource is determined by the 
following:

1)      The User ID used will be the last one used while connecting to the 
datasource.

2)      If there was no previous connection to the datasource, the User ID 
used will be the User ID used to connect to the previous datasource.

3)      If there was no previous User ID entered, the User ID used will be the 
User ID entered in the User ID field on the Preferences Window.

4)      If no User ID was entered in the User ID field on the Preferences 
Window, the User ID will be left blank and required to be entered.

See Also:
Connecting To a Datasource



Using the Menu
There are various ways within MDS PowerBase to Access it's features and functions.    One 
of those ways is by using  Menus.    There are two types of Menus available in MDS 
PowerBase.    The Main Menu and Pop-Up Menus.
The Main Menu

The Main Menu is located above the toolbar.    It has various selections some of which 
are dynamic.    That is, some of the selections are not always available.    For example, 
the Menu Selection BUILD SQL is only available to be used when the system determines 
that it has the ability to actually build a SQL statement.
All of the selections on the Main Menu are menus themselves.    This means that 
selecting one of the Main Menu selections will display another menu from which you will 
make another selection.
The following selections (Menus) are displayed on the Main Menu.    Click on the Menu 
Item to view information about the Menu and it's selections:

File Menu
Edit Menu
Datasources Menu
Query Menu
WHERE Clause Menu
Order/Group By Menu
SQL Server Menu
Windows Menu
Help Menu

Pop-Up Menus
Pop-Up menus are associated with fields and contain menu selections that are 
applicable to the field.    For example, the Pop-Menu for the Table List Field contains the 
selections TABLE DETAILS, and PRINT.    The TABLE DETAILS selection displays detailed 
information about tables.    The PRINT selection prints detailed information about tables.  
So these two menu selections are applicable to the Table List Field.
Pop-Up Menus are accessed by clicking the right mouse button over a field or by 
pressing the <ALT-M> key combination while the cursor is in a given field.    In either 
case, if the field has a Pop-Up menu it will be displayed.    Refer to the Help Topic on a 
specific field to determine if that field has a Pop-Up Menu.

See Also:
Pop Up Menu



Using the Toolbar
There are various ways within MDS PowerBase to Access it's features and functions.    One 
of those ways is by using the toolbar.    The toolbar is located at the top of the screen and 
is accessed by clicking on one of it's buttons.    You can also use the TAB key to TAB to the 
appropraite button then press the enter key.
Click on a toolbar button to view what it's function is.
Main Toolbar (Displayed when the application is first entered)

The following button is only displayed when the SQL WHERE Clause Criteria 
Window is being used)

The following button is only displayed when the SQL Script Facility Window is 
being used)

See Also:
Using the Menu



Where Clause List field
Purpose:    The Where Clause List Field is located on the SQL Where Clause Criteria 

Window.    It lists all of the statements that will be used to build the WHERE 
clause of a SQL SELECT statement built using the Build SQL button/menu option.  
This field has Extended Selection capabilities.

Using:    Adding A WHERE Statement To The List
The following steps are taken to add a WHERE statement to the WHERE 
Clause List.

1)      Select a column from the Column Name List field.    The column 
selected will be used on the left side of the comparison type field.    For 
example, if you wanted to create the WHERE statement :

                          WHERE    USER_ID    =    "JOHN"
USER_ID would be the column name you would select from the Column 
Name List.

2)      Select a comparison type from the Comparison List field.    This field 
lists various comparison operators such as Equals, Greater Than, and 
Less Than.    In our above example, the comparison type would be 
Equals.

3)      Enter a value in the Column Value field.    It is the value to which the 
selected column will be compared.    In our above example, the value 
entered would be JOHN.

4)      Select a value from the And/Or Selection field if the WHERE Clause is 
going to consist of multiple statements.    The following is an example of 
a multiple statement WHERE Clause:
WHERE    USER_ID    =    "JOHN"    AND    STATE = "GA"

5)      Choose the Add To Where Clause Menu selection from the WHERE 
Clause Menu or the Pop-Up menu of the Column Name field.    This will 
add the WHERE Statement to the end of the WHERE Clause List.

Note: The WHERE Clause does not get built until the BUILD SQL 
toolbar/menu selection is used.

Removing A WHERE Statement From The List
There are two ways to remove one or more WHERE statements from the 
WHERE Clause List Field.    They are:

1)      Select (click on) one or more statements in the list.    Press the DELETE
key on your PC.

2)      Select (click on) one or more statements in the list.    Select the 
Remove From WHERE Clause menu option from the WHERE Clause 
Menu or the WHERE Clause List field Pop-Up Menu.

Clearing (Removing All Column Names) The List
There are two ways to remove all the remove all the statements from the 
WHERE Clause Field.    They are:

1)      Select the Clear WHERE Clause menu option from the    WHERE 
Clause Menu or the WHERE Clause List field Pop-Up Menu.

2)      Click on any item in the WHERE Clause List field, then use the Clear 
toolbar/menu option.



Pop Menu:    The following selections are on the Pop Up Menu for this field:
Remove From WHERE Clause - Removes the WHERE statements selected in 
the WHERE Clause List field from the list.
Clear WHERE Clause - Removes all the WHERE statements in the WHERE 
Clause List field from the list.

See Also:
Add WHERE Clause
Creating Queries
Using the Menu
Using the Toolbar



WHERE Clause Menu
The WHERE Clause Menu contains selections used to create SQL WHERE statements.    It is 
visible only while working on the SQL Where Clause Criteria Window    The following 
selections are available from the menu:
Add To WHERE Clause

This selection adds the WHERE statement built to the WHERE Clause List field.
Remove From WHERE Clause

This selection removes the WHERE statements selected in the WHERE Clause List field 
from the list.

Clear WHERE Clause
This selection removes all the WHERE statements in the WHERE Clause List field from 
the list.

Build SQL Statement
Builds a SQL SELECT statement using the following SQL SELECT information:

*    Selected columns from the Column List Field on the Datasources Window
*    WHERE Clause, if entered
*    ORDER BY Clause, if entered
*    GROUP BY Clause, if entered
*    DISTINCT if selected on the Query Menu

See Also:
Creating Queries
Using the Menu
Using the Toolbar



Windows Menu
The Windows Menu contains selections for managing and navigating through open    
windows within MDS PowerBase.    The following selections are available from the menu:
Tile

This selection will arrange and display all non-minimized MDS PowerBase windows in a 
tiled format.

Cascade
This selection will arrange and display all non-minimized MDS PowerBase windows in a 
cascaded format.    That is, one overlapping the other.

Arrange Icons
This selection will arrange all of the icons for the minimized MDS PowerBase windows at 
the bottom of the MDS PowerBase application frame.

Close All Windows
This selection will close all windows (minimized and non-minimized) within the MDS 
PowerBase application.    The only window which does not get closed is the Datasources 
Window.

Datasources
This selection displays the Datasources window.    It is used to quickly locate the 
Datasources Window among all the other open windows.

Results
This selection displays the most recently used Query Results Window.    It is used to 
quickly locate the Query Results Window among all the other open windows.

Query
This selection displays the most recently used Query Window.    It is used to quickly 
locate the Query Window among all the other open windows.

Open Window List
This selection contains a list of all open windows within MDS PowerBase.    Selecting a 
window from the list will display that window.    The list is used to quickly locate a given 
window among all the other open windows.

See Also:
Using the Menu



Time of Day
This section of the status bar displays the current time of day.



Number Of Rows To Retreive
This section of the status bar displays the number of rows that will be returned in the result
set of a query.    If the value ALL ROWS is displayed, all rows will be returned in a result 
set.    If a number is displayed, the number of rows returned will be the number displayed.    
See the help text on the ROWCOUNT parameter for further information on limiting the 
number of rows returned in a result set.



Comments
This section of the status bar is used to display the progress of processing.    It is also used 
to identify what each field on a window is used for.    For example, while running a query, 
this section will contain information such as the number of rows being returned by the 
query.    This section might also contain the text "Enter a default password to connect to a 
datasource" while you are working in the Password field on the Preferences Window.



Date
This section of the status bar displays the current date.




